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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are 
required to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may 
be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from 
the use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.  

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous 
environment, which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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Summary of Changes This manual describes how to install, configure, operate, and troubleshoot the 
PanelView™ Plus 7 Performance terminals. It does not provide procedures on how 
to create applications that run on the terminals or ladder logic that runs in the 
controller.

This manual contains new and updated information as indicated in the following 
table.

Other tasks that you must do include:
• Create a human machine interface (HMI) application for the terminal by 

using FactoryTalk® View Machine Edition (ME) software, version 8.x or 
later.

• Create ladder logic for the controller by using the Studio 5000 Logix 
Designer® application.

Note: This document does not provide instructions on how to install and 
configure components of the ArmorView Plus 7 product. For instructions on 
how to do that, see the ArmorView Plus 7 Installation Instructions, publication 
2711P-IN013.

Topic Pages

Added catalog numbers for the new SDHC cards. 13, 21, and 
134

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Package Contents This product is shipped with these items:
• PanelView Plus 7 Performance terminal with FactoryTalk View ME 

Station runtime software installed and activated
• Removable power terminal block
• Product information
• Cutout template
• Mounting levers for panel installation (for aluminum terminals)
• Mounting clamps for panel installation (for stainless steel terminals)
• Backing plate (for stainless steel terminals)
• Hygienic gasket, blue (for stainless steel terminals)

For information on what is shipped with the ArmorView Plus 7 terminal, see the 
ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

Product Firmware and 
Release Notes

Product firmware and release notes are available online within the Product 
Compatibility and Download Center.

1. From the Search bar on http://ab.rockwellautomation.com, choose 
Compatibility and Downloads.

2. Search for your product.

3. On the search results page, find the firmware and release notes for your 
product.

4. See the Product Compatibility and Download Center Quick Start Guide, 
publication PCDC-QS001, for instructions on how to find and download 
firmware and release notes for the terminal.

http://ab.rockwellautomation.com
http://literature.rockwellautomation.com/idc/groups/literature/documents/qs/pcdc-qs001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Additional Resources These documents contain additional information concerning related products 
from Rockwell Automation.

You can view or download publications, certificates, and declarations of 
conformity at http://www.rockwellautomation.com/global/literature-library/ 
overview.page.

Resource Description

PanelView Plus 7 Performance Specifications, publication 2711P-TD009 Provides technical specifications, environmental specifications, and certifications for the 
performance models of the PanelView Plus 7 Performance terminals.

EtherNet/IP Device Level Ring Application Technique, publication ENET-AT007 Provides information on how to install, configure, and maintain linear and Device Level 
Ring (DLR) networks using Rockwell Automation® EtherNet/IP devices with embedded 
switch technology.

ArmorView Plus 7 Installation Instructions, publication 2711P-IN013 Provides instructions on how to install, configure, troubleshoot, and maintain the 
ArmorView Plus 7 terminal.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1 Provides general guidelines for installing a Rockwell Automation industrial system.

Guidelines for Handling Lithium Batteries Technical Data, publication AG-5.4 Provides guidelines for how to store handle, install, and dispose of lithium batteries.

Product Certifications website : rok.auto/certifications Provides declarations of conformity, certificates, and other certification details.

http://literature.rockwellautomation.com/idc/groups/literature/documents/td/2711p-td009_-en-p.pdf
https://rok.auto/certifications
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/td/ag-td054_-en-p.pdf
https://www.rockwellautomation.com/en_NA/literature-library/overview.page
https://www.rockwellautomation.com/en_NA/literature-library/overview.page
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Chapter 1

Overview

About the PanelView Plus 7 
Performance Terminals

The PanelView™ Plus 7 Performance terminals are operator interface devices. 
They monitor and control devices that are attached to ControlLogix® and 
CompactLogix™ 5370 controllers on an EtherNet/IP™ network. Animated 
graphic and text displays provide operators a view into the operating state of a 
machine or process. Operators interact with the control system by using touch 
screen or keypad input.

Features include the following:
• FactoryTalk® View Machine Edition software, version 8, provides a 

familiar environment for creating HMI applications.
• Microsoft® Windows® CE operating system with desktop access for 

configuration and third-party applications.
• Ethernet communication that can support Device Level Ring (DLR), 

linear, or star network topologies.
• Web browser, Microsoft file viewers, text editor, PDF viewer, remote 

desktop connection, and media player on the terminal desktop.
• Conformal-coating available for all DC power, touch-only terminals 

and the 15-inch DC power, touch and keypad terminal.

Topic Page Topic Page

About the PanelView Plus 7 Performance 
Terminals 16 Start-up Options 17

Hardware Features 13 EtherNet/IP Communication 17

Operator Control 14 Typical Configuration 18

Software Support 15 Catalog Number Explanation 18

Windows CE Operating System 16 Product Selections 19

Open Versus Closed System 17 Accessories 20

Desktop Access 17 Ethernet Cables 21
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• Stainless steel, hygienic, brandless, DC-power, and conformal-coating 
are available for the 9-in. wide-screen, touch-only units and the 12-in. 
wide-screen, touch- only units.

• On-machine mounting available for the 12-in. terminal. For 
information on the options available, see the ArmorView™ Plus 7 
Installation Instructions, publication 2711P-IN013.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Hardware Features The PanelView Plus 7 Performance terminals feature fixed hardware 
configurations with a range of display sizes and operator input options.
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Stainless steel terminals use mounting clips. All other 
hardware features are the same as the aluminum terminals.

Table 1 - Hardware Features(1)

(1) For information about the hardware features of the ArmorView PLus 7 terminal, see the ArmorView Plus 7 Installation 
Instructions, publication 2711P-IN013.

Item Feature Description

1 Display/Keypad

TFT color graphic displays with a touch screen and navigation button in a range of 
sizes. Some models also have a keypad and function keys providing additional 
operator input options:
• 6.5-in. touch, or touch with keypad 
• 9-in. widescreen touch 
• 10.4-in. touch, or touch with keypad 
• 12.1-in. widescreen touch
• 15-in. touch, or touch with keypad
• 19-in. touch

2 Power
AC or DC power input:
• 18…30V DC (isolated), aluminum and stainless steel terminals
• 100…240V AC (nom), only aluminum terminals

3

Mounting slot 
(aluminum 
terminals) 

Slots on top, bottom, and sides of terminal are for mounting levers to mount the 
device to a panel or enclosure. The number of slots varies by terminal size.

Mounting slot 
(stainless steel 
terminals)

Slots on top, bottom, and sides of terminal are for mounting clips to mount the 
device to a panel or enclosure. The number of slots varies by terminal size.

4 Ethernet ports Two 10/100Base-T, Auto MDI/MDI-X, Ethernet ports for controller communication 
supporting Device Level Ring (DLR) network topology.

5 USB host ports Two USB 2.0 high-speed (type A) host ports.

6 USB device port IMPORTANT: The device port is not functional. Do not use this port.

7 Audio out(2)

(2) The speaker works in the Windows CE operating system (Windows Media Player). FactoryTalk View ME Station software does not 

support the speaker.

One audio out port supports connection to a 4 Ω or 8 Ω speaker or amplifier.

8 Status indicators Light-emitting diodes on the back of the terminals provide status and fault 
conditions.

9 Secure Digital (SD) 
card slot

One SD card slot supports catalog number 1784-SDx and 1784-SDHCx, hot-
swappable, SD card for external storage.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Operator Control All terminals have a color display with a touch screen, or touch screen and 
keypad, for operator control.

• Analog resistive touch screens provide accurate and durable touch 
control for industrial applications.

• Keypad models are similar except for the number of function keys to the 
left and right of the display. Larger models have more keys.

ATTENTION: The keypad and touch screen accept input from a finger, stylus, 
and gloved-hand for operation in dry or wet environments. The plastic stylus 
must have a minimum tip radius of 1.3 mm (0.051 in.). Any other object or 
tool can damage the keypad or touch screen.

ATTENTION: To help prevent unintended operation, do not conduct 
multiple operations simultaneously.

• Touch only one operating element on the touch screen with one finger at 
one time.

• Press only one key on the terminal at one time.
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Table 2 - Terminal Keypad

Item Feature Description

1 Numeric keypad

Contains numeric, decimal, minus, and the following keys:
• Backspace - deletes the character to the left of the insertion point.
• Enter - inputs the currently highlighted key or enters a blank line if the 

insertion point is in the text box of the virtual keyboard.
• Tab-left, Tab-right - selects the previous or next control or input element.
• Esc - cancels or dismisses a dialog.

2 Navigation keys

Provides navigation control.
• Arrow keys - selects a key on the virtual keyboard that is above, below, left, or 

right of the selected key. Moves the cursor in selected direction if in the text 
box.

• Home/End - moves the insertion point to the beginning or end of a text or 
numeric entry field.

• Page up/Page down - goes to the next or previous pages of a list.

3

Function keys

6.5-in. terminal
10-in. terminal
15-in. terminal

Performs specific commands if events are configured for a screen or any of its 
graphic elements. For example, F1 can be configured to navigate to another 
screen.
• F1…F6 and F7…F12 
• F1…F8 and F9…F16
• F1…F10 and F11…F20
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Touch Gestures

The touch screen supports touch gestures to interact with screen elements 
during runtime. Standard touch gestures include:

• Tap – Briefly touch the target on the screen with your fingertip.
• Double-tap – Touch the target on the screen twice quickly with your 

fingertip.
• Drag – Touch the target and move your fingertip across the screen 

without losing contact. 
• Long press – Touch and hold the target on the screen for several 

seconds. 

Software Support
IMPORTANT It is the responsibility of the customer to be sure that any third-party 

software, updates, patches, or firmware that is installed is free of malicious 
programs, spyware, and so on.

Table 3 - PanelView Plus 7 Performance Software Support

Software Description Version

FactoryTalk View Machine Edition (ME) Station

Runtime environment of terminal:
• Runs FactoryTalk View ME applications.
• Provides options to view and configure 

terminal settings.
Machine Edition Station is pre-loaded on 
each terminal and does not require 
activation.

8.x or later

FactoryTalk View Studio for Machine Edition

Software for developing HMI applications 
that run on terminal. RSLinx® software is 
included with FactoryTalk View Studio 
software and loaded during installation. 

8.x or later

FactoryTalk ViewPoint

A web server application that lets remote 
users access and control the HMI 
application running on a terminal by 
using an internet browser. 
One license is embedded with each 
terminal to support one client connection 
to a terminal. 

1.2 or later
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Windows CE Operating 
System

The terminals run the Windows CE operating system. The terminals run HMI 
applications and offer desktop access with extended features and file viewers. 

Table 4 - Operating System Features 

Features Icon

Standard features

FTP server –

VNC client server –

ActiveX controls (1) (2)

(1) For a complete list of ActiveX controls, go to https://rockwellautomation.custhelp.com and search the Knowledgebase for 

keywords ‘ActiveX Support for PanelView Plus Terminals’. 

(2) See View FactoryTalk View ME Station Information on page 82 to view a list of ActiveX controls installed on terminal.

–

Third-party device support –

PDF reader

Extended features

Internet Explorer web browser

Remote desktop connection

Media player

Microsoft Office file viewers
• PowerPoint
• Excel
• Word
• Image viewer

WordPad text editor

https://rockwellautomation.custhelp.com
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Open Versus Closed System You can configure a terminal to run an open or closed desktop environment:
• An open system launches the Windows desktop on startup.
• A closed system launches a FactoryTalk View Machine Edition 

application or FactoryTalk View Machine Edition Station on startup. 
Desktop access is restricted. 

All terminals are shipped as closed systems with desktop access disabled. The 
first time that you start the system, the terminal launches FactoryTalk View 
ME Station Configuration mode. At this point, you can change the start-up 
option and allow desktop access.

Desktop Access You can allow or restrict access to the Windows desktop on the terminal. From 
the desktop, you can perform system and control panel operations, use 
Microsoft® file viewers, run third-party applications, and launch the web 
browser. You can also provide temporary access to perform specific tasks, then 
disable desktop access to help prevent unauthorized changes.

See Desktop Access on page 54 for details on how to modify desktop access.

Start-up Options The terminal can perform one of three actions at startup:
• Launch a FactoryTalk View Machine Edition HMI application.
• Launch FactoryTalk View Machine Edition Station in Configuration 

mode. This mode lets you configure terminal settings and start-up 
options, load applications to run, and enable or disable desktop access. 

• Launch the Windows desktop.

The factory default state and start-up option following a firmware update is to 
launch the terminal in Configuration mode. See Configure Start-up Options 
on page 58 for details on how to change the start-up option.

For a list of actions you can perform using touch gestures, see the FactoryTalk 
View Machine Edition help.

EtherNet/IP Communication The PanelView Plus 7 Performance terminals use an EtherNet/IP embedded 
switch. These terminals communicate with ControlLogix and CompactLogix 
controllers over an Ethernet connection with DLR, linear, or star network 
topologies.

The terminals can reside on EtherNet/IP networks that run integrated motion 
and CIP Sync™ applications without affecting performance. The terminal is not 
a consumer or producer of CIP Sync or motion packets. 

TIP All terminals are initially shipped with desktop access disabled. 
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Typical Configuration Traditional DLR, linear, and star network topologies are supported. See these 
topics for examples:

• Device Level Ring Network Topology on page 45
• Linear Network Topology on page 46
• Star Network Topology on page 47

Catalog Number Explanation This section provides an explanation of the catalog numbers.

Bulletin Input Type Display Size Display Type Network Power
Operating 

System
Model(1) - Option 

| | | | | | | | |

2711P- T = Touch 7 = 6.5-in. C = Color 22 = Ethernet DLR ports A = AC  9 = Windows CE P =Performance - B = No brand identity

B = Key and 
Touch 9 = 9-in. W = Wide aspect ratio 

color D = DC -

BSHK (2)= No brand 
identity, stainless steel, 
hygienic, conformal 
coated

10 = 10.4-in. K = Conformal coated

12 = 12.1-in.
BM001– BM016(3) = 
ArmorView Plus 7 
terminal

15 = 15-in.

19 = 19-in.

(1) Performance model s support Windows CE 6.0 operating system with extended features: web browser, remote desktop connection, media player, Microsoft office file viewers, Word Pad text editor.
(2) The -BSHK terminals are available in 9-in. and 12.1-in. touch screen terminals, with DC power, and without the Allen-Bradley logo.

(3) The ArmorView Plus 7 product includes a 12.1-in. PanelView Plus 7 Performance terminal and a 1732E ArmorBlock® EtherNet/IP I/O module. Both products are enclosed in a cast aluminum assembly 

that can be mounted on a machine, an arm mount system, a VESA-compatible bracket (with the optional VESA kit), or a pedestal. To order an ArmorView Plus 7 terminal, add BM001…BM016 to the 
12.1-in. PanelView Plus 7 Performance touch terminal, 2711P-T12W22D9P. For explanations of the ArmorView Plus 7 catalog numbers, see the ArmorView Plus 7 Installation Instructions, 

publication 2711P-IN013.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Product Selections Table 5 provides a description of the product selections by catalog number.
Table 5 - PanelView Plus 7 Performance Terminal Product Selections 

Cat. No.(1) Display Ethernet  Power Memory

Touch Key and Touch  Size Type DLR AC or DC RAM User(4)

2711P-T7C22D9P 2711P-B7C22D9P

6.5-in. VGA 
TFT Color 

Yes

DC

1 GB 512 MB

2711P-T7C22D9PK(2) –

2711P-T7C22A9P 2711P-B7C22A9P AC

2711P-T9W22D9P

– 9-in. 
(wide)

WVGA 
TFT Color 

DC2711P-T9W22D9PK(2)

2711P-T9W22D9P-BSHK

2711P-T9W22A9P AC

2711P-T10C22D9P 2711P-B10C22D9P

10.4-in. SVGA 
TFT Color 

DC
2711P-T10C22D9PK(2) –

2711P-T10C22A9P 2711P-B10C22A9P AC

2711P-T12W22D9P(3)

– 12.1-in. 
(wide)

WXGA 
TFT Color 

DC2711P-T12W22D9PK(2)

2711P-T12W22D9P-BSHK

2711P-T12W22A9P AC

2711P-T15C22D9P 2711P-B15C22D9P

15-in.  XGA 
TFT Color

DC
2711P-T15C22D9PK(2) 2711P-B15C22D9PK(2)

2711P-T15C22A9P 2711P-B15C22A9P AC

2711P-T19C22D9P

– 19-in.  SXGA 
TFT Color

DC
2711P-T19C22D9PK(2)

2711P-T19C22A9P AC

(1) Add -B to the end of a catalog number to order a terminal without the Allen-Bradley logo and product identification, for example, 2711P-

T9W22D9P-B.
(2) This terminal includes conformal coating.

(3) To order an ArmorView Plus 7 terminal, add BM001…BM016 to the 12.1-in. PanelView Plus 7 Performance touch terminal, 

2711P-T12W22D9P. For explanations of the ArmorView Plus 7 catalog numbers, see the ArmorView Plus 7 Installation Instructions, 

publication 2711P-IN013.
(4) Memory available for user to store applications.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Accessories Table 6…Table 10 list accessories for the PanelView Plus 7 Performance 
terminals.

For a list of accessories that are available for the ArmorView Plus 7 terminal, see 
the Visualization Solutions Selection Guide, publication VIEW-SG001.

Table 6 - Protective Overlays 

Cat. No.(1)

(1) The use of protective overlays may not be compatible in all hygienic applications. Consult the standards and 
protocols for your hygienic applications before you use a protective overlay on a stainless steel terminal.

Display Size Operator Input Quantity

Touch Key and Touch

2711P-RGT7SP
6.5-in.

•

3

2711P-RGB7P •

2711P-RGT9SP 9-in. (wide) •

2711P-RGT10SP
10.4-in.

•

2711P-RGB10P •

2711P-RGT12SP 12.1-in. (wide) •

2711P-RGT15SP
15-in.

•

2711P-RGB15P •

2711P-RGT19P 19-in. •

Table 7 - Power Supplies and Power Terminal Blocks

Cat. No. Description Quantity

1606-XLP95E DIN rail power supply, 24…28V DC output voltage, 95 W 1

1606-XLP100E DIN rail power supply, 24…28V DC output voltage, 100 W 1

2711P-RSACDIN DIN rail power supply, AC-to-DC, 85…265V AC, 47…63 Hz 1

2711P-RTBAP 3-pin AC power terminal block (gray with black labels for L1, L2N, and 10

2711P-RTBDSP 3-pin DC power terminal block (black with white labels for +, –, and GND) 10

Table 8 - Mounting Hardware

Cat. No. Description Quantity

2711P-RMCP(1)

(1) Catalog number 2711P-RMCP mounting levers are used with PanelView Plus 7 Performance terminals. Do not use gray 

mounting levers; they are not compatible with PanelView Plus 7 Performance terminals. 

Mounting levers (black) 16

2711P-RTMC(2)

(2) Catalog number 2711P-RTMC mounting clips are used for stainless steel terminals, catalog numbers 2711P-T9W22D9P-BSHK, or 

2711P-T12W22D9P-BSHK. Catalog number 2711P-T12W22D9P-BSHK requires 10 mounting clips. If you need more than eight 

clips, order two 2711P-RTMC mounting clip kits.

Mounting clips 8

https://literature.rockwellautomation.com/idc/groups/literature/documents/sg/view-sg001_-en-p.pdf
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Ethernet Cables See the Industrial Ethernet Media Brochure, publication 1585-BR001, for 
recommended Ethernet cables and media solutions.

See the USB to Serial Adapter Quick Start Guide, publication 
GMSC10-QS003, for information on USB to serial port adapters.

Table 9 - Secure Digital (SD) Cards(1)

(1) To help reduce the chance of corruption when you use SD Cards or USB drives with the terminal, Rockwell Automation 

recommends that you use only the above SD card catalog numbers.

Cat. No. Description Quantity

1784-SD1 1 GB SD card 1

1784-SD2 2 GB SD card 1

1784-SDHC8 8 GB High Capacity SD card 1

1784-SDHC32 32 GB High Capacity SD card 1

2711C-RCSD USB to SD adapter for SD card 1

Table 10 - Battery Replacement

Cat. No. Description Quantity

2711P-RY2032 Lithium coin-cell battery, CR2032 equivalent 1

IMPORTANT Before you select the appropriate replacement gasket, you must identify the 
series of the PanelView Plus 7 Performance Stainless Steel terminal. The 
terminal’s series information is located on the terminal’s product nameplate 
label. In the following table, gaskets that are listed for use on Series B 
terminals are not certified for use on Series A terminals, and gaskets that are 
listed for use on Series A terminals are not certified for use on Series B 
terminals.

Table 11 - Hygienic Gasket Replacement Kits for Stainless Steel Terminals

Cat. No. Description (1)

(1) Gasket material is compliant with FDA 21 CFR 177.2600.

Terminal 
Series

Quantit y

2711P-RGST9W
Hygienic gasket, blue silicone
For 9-in. Series A Stainless Steel Terminals 

A 1

2711P-RGST12W
Hygienic gasket, blue silicone
For 12-in. Series A Stainless Steel Terminals 

A 1

2711P-RGST9WB Hygienic gasket, blue, silicone, with ribs
For 9-in. Series B Stainless Steel Terminals

B 1

2711P-RGST12WB Hygienic gasket, blue, silicone, with ribs
For 12-in. Series B Stainless Steel Terminals

B 1

http://literature.rockwellautomation.com/idc/groups/literature/documents/br/1585-br001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/qs/gmsc10-qs003_-en-p.pdf
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Chapter 2

Install the PanelView Plus 7 Performance 
Terminal

This chapter describes how to install a PanelView® terminal in the door or wall 
of a NEMA rated, UL Type rated, or IP rated enclosure. For instructions on 
how to install the PanelView terminal on a machine, pedestal, or wall, see the 
ArmorView™ Plus 7 Installation Instructions, publication 2711P-IN013.

Topic Page

Hazardous Locations 25

Mounting Considerations 27

Mounting Clearances 28

Panel Guidelines 28

Panel Cutout Dimensions 28

Prepare For Panel Mounting 29

Mount the Aluminum Terminal in a Panel 33

Mount the Stainless Steel Terminal in a Panel 36

Outdoor Installation 38

Remove and Replace Power Terminal Block 40

Connect to DC Power 41

Connect to AC Power 42

Connect to a Network 43

Initial Startup 47

Reset the Terminal 48

ATTENTION: Do not use a PanelView Plus 7 Performance terminal for 
emergency stops or other controls critical to the safety of personnel or 
equipment. Use separate hard-wired operator interface devices that do not 
depend on solid-state electronics. Some configurations of the ArmorView 
Plus 7 terminal include a separate emergency stop button that can be hard-
wired.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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ATTENTION: Environment and Enclosure
This equipment is intended for use in a Pollution Degree 2 industrial environment, in overvoltage Category II applications (as 
defined in IEC 60664-1), at altitudes up to 2000 m (6561 ft) without derating.

The terminals are intended for use with programmable logic controllers. Terminals that are AC powered must be connected to 
the secondary of an isolating transformer. 

This equipment is considered Group 1, Class A industrial equipment according to IEC CISPR 11. Without appropriate precautions, 
there may be difficulties with electromagnetic compatibility in residential and other environments due to conducted or radiated 
disturbances.

Korean Radio Wave Suitability Registration - When so marked this equipment is registered for Electromagnetic 
Conformity Registration as business equipment (A), not home equipment. Sellers or users are required to take 
caution in this regard.

이 기기는 업무용 (A 급 ) 전자파적합기기로서 판 매자 또는 사용자는 이 점을 주의하시
기 바라 며 , 가정외의 지역에서 사용하는 것을 목적으 로 합니다 .

This equipment is supplied as open-type equipment. It must be mounted within an enclosure that is suitably designed for those 
specific environmental conditions that will be present and appropriately designed to prevent personal injury resulting from 
accessibility to live parts. The interior of the enclosure must be accessible only by the use of a tool. The terminals meet specified 
NEMA, UL Type, and IEC ratings only when mounted in a panel or enclosure with the equivalent rating. Subsequent sections of 
this publication may contain additional information regarding specific enclosure type ratings that are required to comply with 
certain product safety certifications.

In addition to this publication, see the following:

• Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1, for additional installation requirements.

• NEMA 250 and IEC 60529, as applicable, for explanations of the degrees of protection provided by different types of 
enclosure.

ATTENTION: Wiring and Safety Guidelines
Use publication NFPA 70E, Electrical Safety Requirements for Employee Workplaces, IEC 60364 Electrical Installations in 
Buildings, or other applicable wiring safety requirements for the country of installation when wiring the devices. In addition to 
the NFPA guidelines, here are some other guidelines to follow:

• Employ only qualified electricians to wire the device in accordance with local, state, and national codes.

• Connect the device and other similar electronic equipment to its own branch circuit.

• Protect the input power by a fuse or circuit breaker rated at no more than 15 A.

• Route incoming power to the device by a separate path from the communication lines.

• Cross power and communication lines at right angles if they must cross. 

• Communication lines can be installed in the same conduit as low-level DC I/O lines (less than 10V).

• Shield and ground cables appropriately to avoid electromagnetic interference (EMI). Grounding minimizes noise from EMI 
and is a safety measure in electrical installations.

For more information on grounding recommendations, see the National Electrical Code published by the National Fire Protection 
Association.

http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1770-in041_-en-p.pdf
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Hazardous Locations This section provides information for hazardous locations.

The terminals(1) have a temperature code of T4 when operating in a 55 °C 
(131 °F) maximum ambient temperature. Do not install product in 
environments where atmospheric gases have ignition temperatures less than 
135 °C (275 °F).

The following information applies when operating this equipment in 
hazardous locations.

Informations sur l’utilisation de cet équipement en environnements 
dangereux.

When marked, these products are suitable for use in "Class I, Division 2, 
Groups A, B, C, D"; Class I, Zone 2, Group IIC hazardous locations and 
nonhazardous locations only. Each product is supplied with markings on 
the rating nameplate indicating the hazardous location temperature 
code. When combining products within a system, the most adverse 
temperature code (lowest "T" number) may be used to help determine 
the overall temperature code of the system. Combinations of equipment 
in your system are subject to investigation by the local Authority Having 
Jurisdiction at the time of installation.

Les produits marqués "CL I, DIV 2, GP A, B, C, D" ne conviennent qu'à une 
utilisation en environnements de Classe I Division 2 Groupes A, B, C, D 
dangereux et non dangereux. Chaque produit est livré avec des marquages 
sur sa plaque d'identification qui indiquent le code de température pour les 
environnements dangereux. Lorsque plusieurs produits sont combinés dans 
un système, le code de température le plus défavorable (code de 
température le plus faible) peut être utilisé pour déterminer le code de 
température global du système. Les combinaisons d'équipements dans le 
système sont sujettes à inspection par les autorités locales qualifiées au 
moment de l'installation.

WARNING: EXPLOSION HAZARD
• Do not disconnect equipment unless power has been 

removed or the area is known to be nonhazardous. 
• Do not disconnect connections to this equipment unless 

power has been removed or the area is known to be 
nonhazardous. Secure any external connections that 
mate to this equipment by using screws, sliding latches, 
threaded connectors, or other means provided with this 
product.

• Substitution of components may impair suitability for 
Class I, Division 2.

• Peripheral equipment must be suitable for the location 
in which it is used.

• The battery in this product must be changed only in an 
area known to be nonhazardous.

• All wiring must be in accordance with Class I, Division 2 
wiring methods of Article 501 of the National Electrical 
Code and/or in accordance with Section 18-1J2 of the 
Canadian Electrical Code, and in accordance with the 
authority having jurisdiction.

AVERTISSEMENT : RISQUE D’EXPLOSION
• Couper le courant ou s'assurer que l'environnement est 

classé non dangereux avant de débrancher l'équipement.
• Couper le courant ou s'assurer que l'environnement est 

classé non dangereux avant de débrancher les connecteurs. 
Fixer tous les connecteurs externes reliés à cet équipement 
à l'aide de vis, loquets coulissants, connecteurs filetés ou 
autres moyens fournis avec ce produit.

• La substitution de composants peut rendre cet équipement 
inadapté à une utilisation en environnement de Classe I, 
Division 2.

• Les équipements périphériques doivent s'adapter à 
l'environnementdans lequel ils sont utilisés.

• S'assurer que l'environnement est classé non dangereux 
avant de changer la pile ou le module horloge temps réel de 
ce produit.

• Tous les systèmes de câblage doivent être de Classe I, 
Division 2, conformément aux méthodes de câblage 
indiquées dans les Articles 501 du National Electrical Code 
(Code Electrique National) et/ou conformément à la Section 
18-1J2 du Canadian Electrical Code (Code Electrique 
Canadien), et en fonction de l'autorité de jurisdiction.

(1) The ArmorView Plus 7 terminal is not certified for use in hazardous locations.
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Required Circuit Port Parameters for USB Peripheral Devices

This product contains USB host ports that comply with hazardous location 
environments. Field wiring compliance requirements are provided in 
compliance with the National Electrical Code, Article 500.

Figure 1 - PanelView Plus 7 Performance Terminal Control Drawing

PanelView Plus 7 Performance terminals provide two, separately powered USB 
host ports. Table 12 defines the circuit parameters of these USB host ports.

Application Information

Per the National Electrical Code, the circuit parameters of associated field-wiring apparatus for use in hazardous 
locations shall be coordinated with the host product such that their combination remains nonincendive. PanelView Plus 
7 Performance terminals and the USB peripheral devices shall be treated in this manner.

The USB peripheral devices and their associated cabling shall have circuit parameters with the limits given in Table 12 
for them to remain nonincendive when used with the PanelView Plus 7 Performance terminal USB host ports. 

If cable capacitance and inductance are not known, use the following values from ANSI/ISA-RP 12.06.01-2003:

Ccable = 197 pF/m (60 pF/ft)
Lcable = 0.7 µH/m (0.20 µH/ft)

Nonincendive Field 
Wiring Apparatus

Associated Nonincendive Field Wiring Apparatus

PanelView Plus 7 Performance Host Product

USB Peripheral Device

USB Peripheral DeviceUSB Host Port

USB Host Port

Table 12 - Circuit Parameters for USB Host Ports

Parameter Value Parameter Definition

V oc (USB) 5.25V DC Open circuit voltage of each host USB port.
The maximum applied voltage rating, Vmax (peripheral), of each USB peripheral device shall be greater 
than or equal to Voc (USB).

Vmax (peripheral) ≥ Voc (USB), 
(as appropriate)

I sc (USB) 1.68 A Maximum output current of each host USB port.
The maximum current, Imax (peripheral), to which each USB peripheral device can be subjected shall be 
greater than or equal to I sc (USB).

Imax (peripheral) ≥ I sc (USB)

C a (USB) 10 μF This value is the maximum total capacitance that can be connected to each USB host port. The total 
capacitance of each USB peripheral device and its associated cable must not exceed the indicated 
value. 

The maximum total capacitance, Ci (peripheral), and cable capacitance of each separate USB peripheral 
device shall be less that or equal to Ca (USB).

Ci (peripheral) + Ccable (USB) ≤ Ca (USB)

L a (USB) 15 μH This value is the maximum total inductance that can be connected to each USB host port. The total 
inductance of each USB peripheral device and its associated cable must not exceed the indicated 
value. 

The maximum total inductance, Li (peripheral), and cable inductance of each separate USB peripheral 
device shall be less than or equal to La (USB).

Li (peripheral) + Lcable ≤ La (USB)
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Nonincendive field wiring must be wired and separated in accordance with 501.10(B)(3) of the National Electrical 
Code, ANSI/NFPA 70, or other local codes as applicable. This associated nonincendive field wiring apparatus has not 
been evaluated for use in combination with another associated nonincendive field wiring apparatus.

Mounting Considerations Consider the following when mounting the terminal: 
• Mount the terminal at a height suitable for most operators. You can 

mount the cabinet at a different level than the operator floor.
• Use appropriate lighting. Do not operate the terminal in direct sunlight.
• Terminals are rated to operate at mounting angles between 0…180°.

Since the ArmorView Plus 7 terminals are pre-mounted in a custom enclosure 
for easy deployment, you may skip the following sections about mounting. For 
instructions on how to mount the ArmorView Plus 7 terminal, see the 
ArmorView Plus 7 Installation Instructions, publication 2711P-IN013.

Figure 2 - Acceptable and Unacceptable Mounting Positions
 

ATTENTION: Failure to follow these guidelines can result in personal injury 
or damage to the panel components.

1
6 66

11

1
6

6
6

1
1

1
66 6

1 1

Yes No

≤ 90°
From Vertical

≤ 90°
From Vertical

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Mounting Clearances Plan for adequate space around the terminal, inside the enclosure, for 
ventilation and cabling. Consider heat that is produced by other devices in the 
enclosure.

The ambient temperature around the terminal must be 0…55 °C (32…131 °F), 
except for the 19-in. terminal that must be 0…50 °C (32…122 °F).

Panel Guidelines The terminals are panel-mount devices that mount in the door or wall of a 
NEMA rated, UL Type rated, or IP rated enclosure:

• Panels must have a thickness of 1.5…4.8 mm (0.060…0.188 in.).
• The material strength and stiffness of the panel must be sufficient to 

hold the terminal and maintain an appropriate seal against water and 
dust.

• The panel surface must be flat and free of imperfections to maintain an 
adequate seal, and NEMA and UL Type ratings.

Panel Cutout Dimensions Use the template that is shipped with your terminal to mark the cutout 
dimensions.

Table 13 - Minimum Required Clearances

Product Area Minimum Clearance

Top 51 mm (2 in.)

Bottom 102 mm (4 in.)

Sides 25 mm (1 in.) on side without an SC card

102 mm (4 in.) on side with an SD card

Back 0 mm (0 in.) (1)

(1) When mounting a stainless steel terminal on a panel thicker than 3.66 mm (0.144 in.), the minimum clearance is from the 
mounting clip, not the back of the terminal.

Table 14 - Panel Cutout Dimensions - PanelView Plus 7 Performance Terminals

Terminal Size Input Type Height, mm (in.) Width, mm (in.)

6.5-in.
Keypad and touch 142 (5.59) 237 (9.33)

Touch 142 (5.59) 184 (7.24)

9-in. Touch 162 (6.38) 252 (9.92)

10.4-in.
Keypad and touch 224 (8.82) 335 (13.19)

Touch 224 (8.82) 269 (10.59)

12.1-in. Touch 218 (8.58) 312 (12.28)

15-in.
Keypad and touch 290 (11.42) 418 (16.46)

Touch 290 (11.42) 353 (13.90)

19-in. Touch 383 (15.08) 457 (17.99)
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Prepare For Panel Mounting

Before mounting a terminal in a panel, read this section and the entire 
installation procedure on page 33.

Mounting levers insert into the slots around the bezel to secure the terminal in 
the panel. The number of levers varies by terminal size.

Each slot has six notches with alignment marks that are locking positions for a 
lever. The thickness of the panel in which you mount the terminal determines 
the locking position that is required to maintain a NEMA/UL Type seal.

Always orient a mounting lever vertically before inserting it into a slot. This 
method is the only way to slide the mounting lever knob within the slot for 
positioning. After sliding the mounting lever to a specific notch, rotate the 
mounting lever toward the panel to lock it in position. The flat side of the 
mounting lever must come into contact with the panel.

IMPORTANT To mount a stainless steel terminal, skip this section and continue with 
Mount the Stainless Steel Terminal in a Panel on page 36.

IMPORTANT Catalog number 2711P-RMCP mounting levers (black) are used with the 
PanelView Plus 7 Performance terminals. Do not use gray mounting levers; 
they are not compatible with PanelView Plus 7 Performance terminals.

Table 15 - Lever Locking Positions

Mounting Slot Lever Lock 
Position

Panel Thickness Range Typical 
Gauge

1 1.50…2.01 mm (0.060…0.079 in.) 16

2 2.03…2.64 mm (0.080…0.104 in.) 14

3 2.67…3.15 mm (0.105…0.124 in.) 12

4 3.17…3.66 mm (0.125…0.144 in.) 10

5 3.68…4.16 mm (0.145…0.164 in.) 8/9

6 4.19…4.80 mm (0.165…0.188 in.) 7

6
1

123456

Notch
Alignment Mark

Orientation of Slot Varies
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Initially, you secure the terminal in the panel by sliding each mounting lever to 
a position that is one or two notches greater than the final lock position. For 
example, if the final lock position is 3, slide each mounting lever to position 4 
or 5. Follow the sequence specific to the terminal size shown in Figure 3 on 
page 32. 

You then adjust each lever to its final lock position in the same sequence. See 
Figure 3 on page 32. 

This figure shows the lever orientation and lock sequence for a 10.4-in. touch 
terminal.

1

Flat Side
Knob on reverse 
side of lever 
inserts into 
large end of slot

1 2 3 4

The edge of the bezel has alignment 
indentations to assist with lever positioning.
The notch on the outside of the lever shows it 
is locked in position 3.

You can use an erasable marker or grease pencil to mark the 
indentations for visibility of slot positions.

Inner notch on lever 
shows current lever 
position. 

TIP If the lock position is 6, slide lever to large end of slot or insertion hole.

IMPORTANT This process equalizes the pressure of the levers against the panel at a 
gradual rate reducing the probability of broken clamps.

54
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Notch shows locked position.

3 1

2 4

8

67

5

This 10.4-in. touch terminal has all levers that are locked in 
position 3, which is appropriate for a panel thickness of 
2.67…3.15 mm (0.105…0.124 in.).
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Figure 3 - Lever Orientation and Lock Sequence
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IMPORTANT: The mounting lever orientations that are shown are required to 
maintain NEMA, UL Type, and IP seals. If you require a NEMA, UL Type, or IP seal, 
do not use a mounting lever in a different orientation than shown.
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Mount the Aluminum 
Terminal in a Panel

The terminals are designed for single-person installation. No tools are required 
except for the tools that are used to make the panel cutout.

To mount the terminal in a panel, follow these steps.

1. Cut an opening in the panel by using the panel cutout template that 
shipped with the terminal, or the cutout dimensions in Table 14 on 
page 28.

2. Verify that the sealing gasket is present on the terminal.

This gasket forms a compression seal. Do not use sealing compounds.

3. Insert and stabilize the terminal in the panel cutout.
a. Insert levers in the top corner slots by using the orientation in 

Figure 3 on page 32, and rotate the curved side of the levers toward 
the panel.

IMPORTANT To mount a stainless steel terminal, skip this section and continue with 
Mount the Stainless Steel Terminal in a Panel on page 36.

ATTENTION: 
Disconnect all electric power from the panel before making the panel cutout.

Make sure that the area around the panel cutout is clear and that the panel is 
clean of any debris, oil, or other chemicals.

Make sure that metal cuttings do not enter any components that are installed in 
the panel, and that the edges of the cutout have no burrs or sharp edges.

Failure to follow these warnings can result in personal injury or damage to 
panel components.

TIP The mounting levers for PanelView Plus 7 Performance terminals are black 
(catalog number 2711P-RMCP).

Do not use gray mounting levers; they are not compatible with PanelView 
Plus 7 Performance terminals.

Gasket

Flat SideCurved Side Curved Side
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b. Tilt the terminal into the panel cutout and guide upward into the 
cutout so that the levers are behind the panel.

c. Pull the top of the terminal toward you to verify that the levers are 
still in place and the terminal is stabilized in the panel.

d. Insert the remaining levers in the slots by using the orientations for 
your terminal in Figure 3 on page 32. 

The direction that you rotate the levers varies for each terminal size. 

4. Slide and rotate each lever to a notch that is one or two positions greater 
than the final lock position, starting with the first lever in the sequence.

For example, if the final lock position is 3, slide the lever to notch 4 or 5.

a. See Figure 15 on page 29 to get the final lock position of the levers.
b. See Figure 3 on page 32 to get the locking sequence.
c. Rotate each lever until its flat side comes in contact with the panel.

TIP The levers help to prevent the terminal from falling out of the panel.

TIP Use the alignment marks or previous marks you made on the bezel 
to help position the levers and identify the final slot position.

54
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5. Adjust each lever to its final lock position by using the same locking 
sequence in Figure 3 on page 32.
a. Unlock lever one in the sequence by rotating it away from the bezel.

b. With the lever positioned vertically to the slot, slide the lever to the 
final locking position in Table 15 on page 29.

The outer notch of the lever aligns with the bezel indentation. 
c. Carefully rotate the lever back toward panel.

d. Lock the remaining levers to their final position.

6. Verify that all levers are in the correct locked position.

The notch on the outside of lever shows its locked position. 

These two views show levers that are locked in position 3.

IMPORTANT Do not use tools or excessive force to rotate the mounting levers. 
The mounting levers are rotated and secured by hand.

TIP A broken mounting lever does not damage the terminal.

The mounting levers are designed to break off the pin if they are 
over torqued. This breakage helps to prevent damage to the 
terminal bezel. If a pin is broken, you can turn the lever around and 
use the lever in another location. See Figure 3 on page 32 for details 
and restrictions.

ATTENTION: All levers must be in the correct and same locked 
position to provide an adequate gasket seal between the terminal 
and the panel. Rockwell Automation assumes no responsibility for 
water or chemical damage to the terminal or other equipment 
within the enclosure because of improper installation.

Flat side



36 Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020

Chapter 2 Install the PanelView Plus 7 Performance Terminal

Mount the Stainless Steel 
Terminal in a Panel

Mounting clips secure the stainless steel terminals in a panel. The number of 
clips varies by terminal size. Tools that are required for installation include 
panel cutout tools, a large slotted or Phillips screwdriver, and a torque wrench 
for tightening the mounting clips.

To mount the stainless steel terminal in a panel, follow these steps.

1. Cut an opening in the panel by using the panel cutout template that 
shipped with the terminal, or the cutout dimensions in Table 14 on 
page 28.

2. Place the terminal screen-down on a clean, flat surface.

Be careful not to scratch or damage the terminal screen.

3. Position the gasket on the bezel, with the gasket alignment plugs facing 
the bezel alignment features.

This gasket forms a compression seal. Do not use sealing compounds.
1 1

Outer Notch Outer Notch

ATTENTION: 
Disconnect all electric power from the panel before making the panel cutout.

Make sure that the area around the panel cutout is clear and that the panel is 
clean of any debris, oil, or other chemicals.

Make sure that metal cuttings do not enter any components that are installed in 
the panel, and that the edges of the cutout have no burrs or sharp edges.

Failure to follow these warnings can result in personal injury or damage to panel 
components.

IMPORTANT Slip the inside corners of the gasket 
under the corners of the bezel 
shroud.
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4. Press each gasket alignment plug into the bezel alignment feature.

The alignment plugs hold the gasket to the bezel.

5. Place the terminal in the panel cutout.

Hold the terminal so it does not fall out of the panel.

6. Position the backing plate over the terminal.

7. Slide the ends of the mounting clips into the slots on the terminal.

IMPORTANT Make sure that the flat side of the backing plate faces away from the 
panel, as shown in the drawing.

Gasket with Alignment Plugs
Back of Bezel with Alignment Features

Panel

Terminal

Backing Plate

Mounting Clips

Panel
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8. Tighten the mounting clip screws by hand until the backing plate 
contacts the panel uniformly.

9. Torque the mounting clip screws to 2.3…2.6 N•m (20…23 lb•in) by 
using the specified sequence.

The clips will loosen as the adjacent clip is tightened.

10. Repeat step 9 until all the mounting clips are at the specified torque.

Outdoor Installation

When using a 2711P terminal outdoors, you must follow the 
recommendations outlined below to maximize the field life of the front bezel 
and display:

• Add UV protection and shielding
• Manage terminal temperature
• Consider terminal orientation
• Select a proper enclosure

Ultraviolet (UV) and infrared radiation can reduce the field life of any 
electronic terminal. While the materials used in the terminal bezels provide 
long field life, that life can be improved by proper installation and by following 
the suggested guidelines.

UV radiation from the sun causes all plastics to fade or yellow and become 
brittle over time. Using a sacrificial antiglare overlay (see Table 6 on page 20) 
helps protect the front of the terminal from direct exposure to UV radiation, 
and by avoiding direct sunlight exposure, this overlay greatly increases its field 
life. Another recommendation for UV protection is a shield to shade the 
terminal from the direct rays of the sun. This also helps reduce the solar heating 
caused by direct sun exposure. When installing a sun shield that closes over the 
display, the temperature between the sun shield and the display cannot exceed 

ATTENTION: Tighten the mounting clips to the specified torque to provide a 
proper seal and to prevent damage to the product. Rockwell Automation 
assumes no responsibility for water or chemical damage to the product or 
other equipment within the enclosure because of improper installation.

9-in. Torque Sequence
8 Clips

12.1-in. Torque Sequence
10 Clips

1

2

3

4

5

6 7

8
2

3

49

10

7 6

85

1

ATTENTION: Failure to follow the recommended installation practices for 
outdoor use will substantially reduce product life and void product warranty.
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the maximum temperature of the display, which is 55 °C (131°F). Adequately 
ventilate all sun shields to help prevent excess heat rise on the terminal display.

Use stirring fans or active cooling in high altitude and high ambient 
temperature locations to keep the internal enclosure temperature below 55 °C 
(131 °F).

Ensure the ambient temperature the product is operating in does not fall below 
its minimum rated 0°C (32°F).

The temperature differential between the inside of the terminal enclosure and 
the front panel must be minimized to reduce the potential for condensation 
and possible pressure variation between the inside and outside of the product. 

Avoid placing the terminal on the south (north in the southern hemisphere) or 
west side of the cabinet. This reduces the heat rise due to solar heating during 
the hottest part of the day.

Mount the terminal vertically to minimize solar heating on the display. Do not 
mount the terminal in a sloped enclosure if it exposes the terminal to direct 
sunlight.

Protect the terminal from water and dust by mounting it in a proper enclosure 
following the instructions in the PanelView Plus 7 Performance Terminals 
Product Information, publication 2711P-PC007. The terminals meet specified 
NEMA, UL Type, and IEC ratings only when properly mounted in a panel or 
enclosure with the equivalent rating. Other sections of this publication may 
contain additional information regarding specific enclosure type ratings that 
are required to comply with certain product safety certifications.

https://literature.rockwellautomation.com/idc/groups/literature/documents/pc/2711p-pc007_-en-p.pdf
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Remove and Replace Power 
Terminal Block

The product has a three-pin terminal block for power connections. You can 
remove the terminal block for ease of installation, wiring, and maintenance.

The terminal block has different markings for AC and DC power connections. 
Use a 0.6 x 3.5 mm screwdriver for terminal block wiring.

To remove the terminal block, follow these steps.

1. Loosen the two screws that secure the terminal block.

2. Gently pull the terminal block away from the connector.

To install the terminal block, follow these steps.

1. Reattach the terminal block to the connector until seated.

2. Tighten the two screws that secure the terminal block to the connector.

WARNING: Explosion Hazard

If you connect or disconnect wiring while the power is on, an electric arc can 
occur. An electric arc can cause an explosion in hazardous location installations. 
Verify that the power is off and the area is nonhazardous before proceeding.

Failure to turn power off can result in electric shock or damage to the terminal.

Table 16 - Wire Specifications for Power Input Terminal Block

Wire Type Dual-wire 
Size(1)

(1) Two-wire maximum per terminal.

Single-wire 
Size

Strip Length Wire Torque Mounting 
Torque

Stranded or solid
Cu 90 °C (194 °F)

0.3…1.3 mm2

22…16 AWG
0.3…2.1 mm2

(22…14 AWG) 7 mm (0.28 in.) 0.4…0.5 N•m 
(3.5…4.4 lb•in)

0.15…0.2 N•m 
(1.3…1.8 lb•in)

1 1

AC Terminal BlockDC Terminal Block

ATTENTION: Do not use excessive force to press the terminal block 
into position. The terminal blocks are keyed to fit the DC or AC 
connector. If the terminal block does not fit into the connector, 
verify that you have the correct terminal block. See Table 7 on 
page 20.
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Connect to DC Power Terminals with a 24V DC power supply have these power ratings:
• 24V DC nominal (18…30V DC)
• 50 W maximum (2.1 A at 24V DC)

Terminals with a DC power input support operation from a safety extra low 
voltage (SELV) or protective extra-low voltage (PELV) 24V DC power supply. 
Supported power supplies include catalog numbers 1606-XLP95E, 
1606-XLP100E, or 2711P-RSACDIN.

You can power the terminal from the same power source as other equipment by 
using a DC power bus. 

To connect the operator terminal to a DC power source, follow these steps.

1. Verify that the wiring is not connected to a power source.

2. Strip 7 mm (0.28 in.) of insulation from the ends of the wires.

3. Secure the DC power wires to the marked terminals (+ and –) on the 
terminal block.

4. Secure the earth ground wire to the GND terminal on the terminal 
block.

ATTENTION: The power supply is internally protected against reverse 
polarity. To avoid damage to the terminal:

• Do not connect DC+ or DC- to the earth ground terminal. 

• Do not connect AC power, or more than 30V DC, to the power terminal block.

ATTENTION: Use a SELV or PELV supply as required by local wiring codes for 
your installation. The SELV and PELV power sources provide protection so 
that under normal and single fault conditions, the voltage between 
conductors and earth ground does not exceed a safe value.

7 mm
20 mm

1 1

GNDDC+ DC–

Performance Terminals

Stainless Steel Terminals
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The GND terminal must be connected to a low-impedance earth 
ground.

5. Apply power to the operator terminal.

Connect to AC Power Terminals with an AC power supply have these power ratings:
• 100…240V AC (50…60 Hz)
• 105VA maximum

To connect the operator terminal to an AC power source, follow these steps.

1. Verify that the wiring is not connected to a power source.

2. Strip 7 mm (0.28 in.) of insulation from the ends of the wire.

3. Secure the AC power wires to the marked terminals (L1 and L2N) on 
the terminal block. 

4. Secure the protective earth ground wire to the marked terminal on the 
terminal block.

The protective earth terminal must be connected to a low-impedance 
earth ground.

ATTENTION: The earth ground connection to ground is mandatory. 
This connection is required for noise immunity, reliability, and 
Electromagnetic Compliance (EMC) with the European Union (EU) 
EMC Directive for CE marking conformance. This connection is 
required for safety by Underwriters Laboratory.

ATTENTION: Improper wiring of the power terminals can result in voltage at 
the communication connector shells. 

Do not apply power to the terminal until all wiring connections have been 
made. Failure to do so can result in electric shock.

Do not connect stainless steel terminals to AC power. Stainless steel terminals 
are only compatible with DC power.

7 mm
20 mm

1 1

L1

L2/Neutral

Protective Earth 
to Ground Bus



Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020 43

Install the PanelView Plus 7 Performance Terminal Chapter 2

5. Apply power to the operator terminal.

Connect to a Network The two Ethernet ports connect to controllers on an EtherNet/IP network by 
using standard Ethernet connections. These network types are supported:

• Device Level Ring Network Topology on page 45 
• Linear Network Topology on page 46
• Star Network Topology on page 47

Each of these EtherNet/IP network topologies supports applications that use 
Integrated Motion over an EtherNet/IP network, if necessary.

Ethernet Ports

The Ethernet port has two 10/100Base-T connectors for network 
communication and supports MDI/MDI-X connections and DLR network 
topology as indicated by the DLR network icon.

The terminal connects to an EtherNet/IP network by using a CAT5, CAT5E, 
or CAT6 twisted-pair, Ethernet cable with RJ45 connectors.

ATTENTION: The earth ground connection to ground is mandatory. 
This connection is required for noise immunity, reliability, and 
Electromagnetic Compliance (EMC) with the European Union (EU) 
EMC Directive for CE marking conformance. This connection is 
required for safety by Underwriters Laboratory.

IMPORTANT The terminal has dual-Ethernet ports but only one device IP address.

Link 1Link 2

1 1

Network Ports
Link 1Link 2

Performance Terminals

Stainless Steel Terminals
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The maximum cable length between the Ethernet ports and a 10/100Base-T 
port on an Ethernet hub (without repeaters or fiber) is 100 m (328 ft).

Each Ethernet port has two indicators that provide the status of activity.

IMPORTANT To help prevent accidental disconnection of the Ethernet cable, follow these 
steps:

• Secure the Ethernet cable to minimize vibration at the connector, and 
reduce the chance that personnel working inside the panel can 
accidentally disconnect the cable.

• Do not install the Ethernet cable too tightly. Leave some slack in the 
cable to help prevent pulling on the cable when the panel door is 
opened and closed.

WARNING: In hazardous locations, do not connect or disconnect any 
communication cable with power that is applied to this device or any device 
on the network. An electric arc can cause an explosion in hazardous location 
installations. Make sure that the power is off or the area is nonhazardous 
before proceeding.

Table 17 - Ethernet Connector Pinout

Connector Pin Pin Name

View of RJ45 
Connector

1 TD+

2 TD-

3 RD+

4 Unused

5 Unused 

6 RD-

7 Unused

8 Unused

Shield Connection No direct connection (AC coupled to chassis GND)

Table 18 - Ethernet Status Indicators

Indicator Color Description

Link Integrity Green On when a link is present.

Activity Yellow Blinks when activity is detected on Ethernet link. 

1 8

Yellow 
Status 

Indicator

Green 
Status 

Indicator
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Device Level Ring Network Topology

A DLR network is a single-fault tolerant ring network that is intended for the 
interconnection of automation devices. This topology is also implemented at 
the device level. No additional switches are required.

DLR network topologies automatically convert to linear network topologies 
when a fault is detected. The conversion to the new network topology 
maintains communication of data on the network. The fault condition is 
typically detected and corrected.

For more information on DLR network topology, see the EtherNet/IP 
Embedded Switch Technology Application Guide, publication ENET-AP005.

Figure 4 - PanelView Plus 7 Performance Terminal in a DLR Topology Network

TIP A DLR network has supervisor nodes and ring nodes. The PanelView Plus 7 
Performance terminal operates only as a ring node on the network.

PanelView Plus 7 
Performance Terminal

Connected Via Two 
Ethernet Ports

1756-ControlLogix® Controller
1769-L18ERM-BB1B Control System

Computer Connected Via a 
1783-ETAP EtherNet/IP Tap

Kinetix® 6500 Drives
with Motors

1734-AENTR POINT I/O™ Adapter
with POINT I/O Modules

1794-AENTR FLEX™ I/O Adapter
with FLEX I/O Modules

PowerFlex® 755 Drive 
Connected Via a 1783-
ETAP EtherNet/IP Tap

http://literature.rockwellautomation.com/idc/groups/literature/documents/ap/enet-ap005_-en-p.pdf
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Linear Network Topology

A linear network topology is a collection of devices that are daisy-chained 
together across an EtherNet/IP network. Devices capable of connecting to a 
linear network topology use embedded switch technology to remove the need 
for a separate switch, as required in Star network topologies.

Figure 5 - PanelView Plus 7 Performance Terminal in a Linear Topology Network

TIP The PanelView Plus 7 Performance terminal with dual Ethernet ports can 
be attached in the middle, or at the end, of a linear network.

PanelView Plus 7 Performance Terminal 
Connected Via One Ethernet Port

Kinetix 350 Drive Connected 
Via a 1783-ETAP EtherNet/IP Tap

Kinetix 350 Drive Connected 
Via a 1783-ETAP EtherNet/IP Tap

ControlLogix Controller with 
1756-EN3TR (or EN2TR) Module

1794-AENTR FLEX I/O Adapter
with FLEX I/O Modules

1734-AENTR POINT I/O Adapter
with POINT I/O Modules

Computer

PanelView Plus 7 
Performance Terminal

Connected Via Two DLR Ports



Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020 47

Install the PanelView Plus 7 Performance Terminal Chapter 2

Star Network Topology

A star network topology is a traditional EtherNet/IP network that has 
multiple devices that are connected to each other via an Ethernet switch.

Figure 6 - PanelView Plus 7 Performance Terminal in a Star Topology Network

Initial Startup The first time that you start the system, the terminal goes through its startup 
sequence and launches FactoryTalk® View ME Station in Configuration mode.

To change the action that occurs at startup, follow these steps.

1. Press Terminal Settings.

2. Tap Startup Options.

You can configure these options:

Computer

Stratix® 6000 Switch

1734-AENTR POINT I/O Adapter
with POINT I/O Modules

Kinetix 350 Drive

1732E-IB16M12R
ArmorBlock®
EtherNet/IP Module

ControlLogix Controller 
with 1756-EN2T Module

PanelView Plus 7 Performance Terminal
Connected Via One Ethernet Port
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• Launch a FactoryTalk View Machine Edition HMI application
• Launch FactoryTalk View ME Station in Configuration mode 

(default).
• Launch the Windows desktop.

For more information on how to change the start-up option and desktop 
access, see Configure Start-up Options on page 58.

Reset the Terminal You have several ways to reset the terminal without having to disconnect and 
reapply power:

• From FactoryTalk View ME Station Configuration Mode, tap Reset.
• From the terminal desktop Start Menu, choose Programs>Restart 

System.
• To access Maintenance Mode, follow these steps.

a. Plug in a USB keyboard.
b. Press and hold the white box that appears in the bottom left corner 

when the terminal is booting up.

See Maintenance Mode Operations on page 160 for details on how to reset the 
terminal from Maintenance Mode.

TIP  Terminals are initially shipped with desktop access disabled. You can also 
configure the terminal to allow desktop access.
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FactoryTalk View ME Station FactoryTalk® View ME Station is the runtime environment of the terminal. 
This environment lets you configure start-up options, load and run HMI 
applications, adjust terminal settings, access the Windows desktop, and 
perform other terminal operations.

When you reset the terminal, one of these actions occurs depending on the 
configured start-up option:

• FactoryTalk View ME Station launches in Configuration mode (factory 
default).

• FactoryTalk View ME .mer application runs.
• Windows desktop launches.

Topic Page Topic Page

FactoryTalk View ME Station 49 Display Settings 70

Terminal Settings 51 Input Device Settings 72

Soft Keyboard 52 Configure Print Options 75

Load and Run Application 53 Configure Diagnostics 77

Desktop Access 54 Check Integrity of Application Files 78

Configure Start-up Options 58 View and Clear the System Event Log 79

Configure Controller Address 61 Enable or Disable the Alarm Display 79

Configure Ethernet Settings 61 Display System Information 80

Modify Device Name of Terminal 67 Time and Date Settings 83

Copy Files on Terminal 68 Regional Settings 85

Delete Files from Terminal 69

IMPORTANT • To access Configuration mode from an HMI application on the terminal, 
press Goto Configuration Mode. This button is added to application 
screens in FactoryTalk View Studio software during application 
development. The application stops running but is still loaded.

• If your application does not have a Goto Configuration Mode button, see 
Enter Configuration Mode on Startup on page 59 for details on how to 
access Configuration mode.

• To access Configuration mode from the Windows desktop, double-click 

the FTViewME Station icon .



50 Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020

Chapter 3 Configure Terminal Settings

Figure 7 - FactoryTalk View ME Station Dialog Box

Table 19 - Terminal Operations

Press To

Load Application [F1] Open a dialog box where you select a .mer application to load in the 
device. You must load an application before you can run it.
The name of the loaded application appears under Current Application.

Run Application [F2] Run the .mer application that is loaded in the terminal.

Application Settings [F3] Open a menu of application-specific settings, such as device shortcuts 
defined for the loaded .mer application. Device shortcuts are read only.
For example, CLX is the device shortcut for a ControlLogix® controller.

Terminal Settings [F4] Open a menu of options to modify terminal settings.

Delete Log Files Before Running [F5] Toggle between Yes and No. 
• Select Yes to delete all data log files, alarm history, and alarm status 

files before running the application. 
• Select No to run the application without deleting log files.

Reset [F7] Reset the terminal and launch an HMI application, FactoryTalk View ME 
Station software, or the Windows desktop. The action that occurs 
depends on the configured startup-option. 

Exit [F8] Exit FactoryTalk View ME Station. If desktop access is allowed, you can 
access the desktop.

Device, IP Address, Subnet
(Display only)

Identifies the device name, IP address, and subnet of the terminal on a 
connected Ethernet network. 
The network information is updated every 60 seconds. If the terminal is 
disconnected from the network, the IP address and subnet appear as 
0.0.0.0.

TIP On devices with a keypad and a touch screen, you can press a function key 
or the touch screen button to access an operation. For example, to access 
terminal settings:

• Press the F4 function key, or

• Press the Terminal Settings touch screen button
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Terminal Settings The terminal has settings that you can adjust that are not specific to the 
application. 

1. Press Terminal Settings from the FactoryTalk View ME Station dialog 
box.

2. Select an option by using the up and down cursor.
• On touch screen terminals, touch the up or down cursor.
• On keypad terminals, press the corresponding key on the keypad.

3. Press Enter to access selected function.

Table 20 - Terminal Settings

Select This Option:  If You Want to:

Alarms Close the alarm display on the terminal when an operator acknowledges the newest alarm. By default, the alarm display is closed.

Diagnostics Setup Forward diagnostic messages from a remote log destination to a computer that runs diagnostics.

Display Adjust the brightness of the display, configure the screen saver, and enable/disable the touch screen cursor.

Desktop Access Setup Allow or restrict access to the desktop. Set or reset the desktop password.

File Management Copy application files and font files to the terminal, an SD card, or a USB drive. You can also delete application files or log files.

Font Linking Link a font file to a base font loaded on the terminal.

Input Devices Configure settings for the keypad, attached keyboard, mouse, or touch screen, including touch screen calibration. You can also choose 
between a popup character input or popup keyboard for string input.

File Integrity Check Check the integrity of the .mer application file and runtime files by logging details to a file integrity check log. You can view and clear 
this log at any time.

Networks and Communications Configure Ethernet and other communication settings for an application.

Print Setup Configure settings to print displays, alarm messages, or diagnostics messages generated by the application.

Startup Options Specify whether the terminal launches the desktop, an application, or FactoryTalk View ME Station Configuration mode on startup. 

System Event Log Display system events that are logged by the terminal, and clear events from the log.

System Information Display power, temperature, battery, and memory details for the terminal. You can also view the firmware revision for FactoryTalk View 
ME Station, and other software loaded on the terminal. Technical support information.

Time/Date/Regional Settings Set the date, time, language, and numeric format used by terminal and applications. 



52 Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020

Chapter 3 Configure Terminal Settings

Soft Keyboard When you activate a data entry field, a keyboard opens. For fields that require 
numeric values only, 0…9 and the decimals are enabled.

To enter characters in the display area above the keyboard, follow these steps.

1. Select a character on the keyboard: 
• On a touch screen terminal, touch a key.
• On a keypad terminal, press the arrow keys to navigate to a key.

2. Press Select to copy the character to the display area.

3. Press Enter when done to exit the keyboard.

Table 21 - Soft Keyboard Controls

Select This Key: To:

SHF Switch keys between their shifted and unshifted state.

CAP Switch between lowercase and uppercase characters. 

SPACE Enter a space between characters in the Display Area.

Backspace Delete the previous character (to the left of the cursor) in the Display Area.

Select Select a character and enter it in the Display Area.

Left, Right, Up, Down Arrow Select the character to the left, right, above, or below the currently selected 
character.

Enter Accept the entered characters and return to the previous dialog box.

ESC Cancel the current operation and return to the previous dialog box.
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Load and Run Application To run a FactoryTalk View ME .mer application on the terminal, you must first 
load the application. You can load the application from internal storage 
(nonvolatile memory) in the terminal, an SD card, or a USB drive.

To load and run an application on the terminal, follow these steps.

1. Press Load Application from the FactoryTalk View ME Station dialog 
box.

2. Press Source to selection the location of the file to load:
• Internal Storage - nonvolatile memory of the terminal.
• External Storage 1 - SD card that is loaded in the card slot.
• External Storage 2 - USB drive that is loaded in the USB host port.

3. Select an .mer file from list by using the up and down cursor keys.

4. To load the selected application, press Load.

You are asked if you want to replace the current communication settings 
for the terminal with the settings that are defined in the application. 

5. Select Yes or No.
• Select Yes to use the communication settings in the application.
• Select No to use the communication settings of the terminal.

The application loads and the application name appears at the top of the 
FactoryTalk View ME Station dialog box.

6. To run the application that you loaded, press Run Application on the 
FactoryTalk View ME Station dialog box.

TIP The path for Machine Edition files on the terminal is My Device\Application 
Data\Rockwell Software\RSViewME\Runtime.

The path for Machine Edition files on the SD card or USB drive is \Rockwell 
Software\RSViewME\Runtime.

TIP Applications generate log files. You can delete log files from the FactoryTalk 
View ME Station dialog box before running the application. Delete log files 
to reclaim memory in the terminal. 

To set the application to run on startup or reset, see Run the Loaded 
Application on Startup on page 60.
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Desktop Access You can allow or restrict desktop access on the terminal. From the desktop, you 
can perform system and control panel operations, use file viewers, the web 
browser, and the media player. You can allow temporary access, then disable 
desktop access to help prevent unauthorized changes.

With restricted access, the only way to access the desktop is to enter a password. 
Each terminal has a default password and challenge question. 

Enable Desktop Access

To enable desktop access, follow these steps.

1. Press Terminal Settings, then choose Desktop Access Setup.

2. To select Allow, press Desktop Access.

The Enter Password dialog box opens. 

Each time that you change desktop access from disallow to allow, you 
must enter a password. The default password is ‘password’. 

3. To type the password, press Password.

4. Press Enter.

5. To return to Desktop Access Management, press Enter again.

Notice that the password is no longer set.

TIP Terminals are shipped from the factory with desktop access disabled.

Default Password Credentials Values

Password password (case sensitive)

Challenge question What is the opposite of lock?

Challenge answer unlock (case sensitive)

TIP Rockwell Automation recommends that you change the default password 
and challenge question and answer to something unique for your 
installation.
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6. Press OK to exit Desktop Access Management, then Close to exit 
terminal settings and return to the FactoryTalk View ME Station dialog 
box.

7. To access the desktop, press Exit.

When desktop access is enabled, you are not required to enter a 
password.

Disable Desktop Access

To restrict desktop access, define a desktop password and challenge question:
• The password lets you access the desktop from FactoryTalk View ME 

Station when pressing Exit.
• The challenge question and response lets you change the password with 

the Reset function.

To disable desktop access, follow these steps.

1. Press Terminal Settings, then choose Desktop Access Setup.

2. To select Disallow, press Desktop Access.

The Set Password button is enabled.

3. See Set a Desktop Password on page 56 to define a new password and 
challenge question.

IMPORTANT To restrict desktop access, the start-up option must be set to either Go to 
Configuration Mode or Run Current Application. See page 58 for details.

IMPORTANT If an error message displays, you can change the startup option to 
Go to Configuration Mode or Run Current Application.

You cannot restrict access to the desktop if Startup Options is 
configured for Do not start FactoryTalk View ME Station.
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Set a Desktop Password

To define a new desktop password, follow these steps.

1. Press Set Password.

The Desktop Access Set Password dialog box opens.

2. Press Set Password, enter an 8…20 character password, then press Enter.

3. Press Set Challenge to enter a challenge question that you must correctly 
respond to when resetting the desktop password.

4. Press Set Response to enter a response to the challenge question, then 
press Enter.

5. Press OK. 

The Desktop Access Management Dialog shows that a password and 
challenge question are set.

6. Press OK to return to terminal settings.

IMPORTANT When you restrict access to the desktop, you must define a new password 
and challenge question.

IMPORTANT You must correctly enter this password before accessing the 
desktop.

IMPORTANT Secure your password and challenge question for future use. To clear and 
reset the password, you must correctly respond to the challenge question. If 
you forget the response, the only way to clear the password is to restore the 
factory default settings on the terminal. See Factory default on page 160.
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Reset the Desktop Password

To clear and change the current password, you must correctly respond to the 
current challenge question. If you do not remember the response, you must 
restore the terminal to its factory defaults. See Maintenance Mode Operations 
on page 160.

To reset the desktop password, follow these steps.

1. Press Reset Password from the Desktop Access Management dialog box.

2. Press Answer Challenge and enter the correct response to the current 
challenge question.

3. Press Clear Password to clear the current password and challenge 
question.

The dialog box shows the updated status of the password and challenge 
information.

4. Press Close.

5. Refer to Set a Desktop Password on page 56 to set a new password and 
challenge question.

After clearing the password, you must set a new desktop password or 
change the desktop access to allow.

IMPORTANT You can reset the password and challenge questions if access to the desktop 
is restricted or set to disallow.
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Configure Start-up Options You can specify what action the terminal takes on startup or a reset.

Disable FactoryTalk View ME Station on Startup

To launch the desktop on startup, you must disable FactoryTalk View ME 
Station. 

To disable FactoryTalk View ME Station on startup, follow these steps.

1. Press Terminal Settings, then choose Startup Options.

2. Press On Startup until ‘Do not start FactoryTalk View ME Station’ is 
selected.

3. Press OK.

This Start-up Option Performs This Action Typical System

Do not start FactoryTalk View ME 
Station

Launches the Windows desktop on startup. Open

Go to Configuration Mode Launches FactoryTalk View ME Station in Configuration 
mode on startup (factory default).

Closed

Run Current Application Runs the FactoryTalk View ME application that is loaded in 
the terminal on startup.

Closed

IMPORTANT When desktop access is restricted, the start-up option must be set to Run 
Current Application or Go to Configuration Mode (default). See page 54 for 
details on how to allow or restrict desktop access.

TIP You can also launch the desktop by pressing Exit on the FactoryTalk View ME 
Station dialog box. 

TIP Desktop access must be set to allow or you get a warning. See 
Enable Desktop Access on page 54.
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Enter Configuration Mode on Startup

To launch FactoryTalk View ME Station in Configuration mode on startup, 
follow these steps.

1. Press Terminal Settings, then choose Startup Options.

2. To select Go to Configuration Mode, press On Startup.

3. To view or change optional settings, press Configuration Mode Options.

4. To specify whether you want to load the current application on startup, 
press Load Current Application.

5. To specify what configuration settings are used when the loaded 
application is run, press Replace RSLinx® Enterprise Communications:
• To use the RSLinx communication settings in the terminal, select 

No. 
• To replace the terminal settings with the communication settings in 

the application, select Yes. Any changes to RSLinx device addresses or 
driver properties on the terminal are lost. 

6. To return to the previous dialog box, press OK.

7. To return to terminal settings, press OK.
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Run the Loaded Application on Startup

To run the FactoryTalk View .mer application that is loaded in the terminal on 
startup, follow these steps.

1. Press Terminal Settings, then choose Startup Options.

2. To select Run Current Application, press On Startup.

3. To view or change optional settings, press Run Options.

If the application is not loaded, the options are disabled.

4. To specify what configuration settings are used when running the 
application, press Replace RSLinx Enterprise Communications:
• To use the RSLinx communication settings in the terminal, select 

No. 
• To replace the terminal settings with the communication settings in 

the application, select Yes. Any changes to RSLinx device addresses or 
driver properties on the terminal are lost.

5. To specify what action to take with the log files on startup, press Delete 
Log Files On Every Power Cycle:
• To delete all log files (data, alarm history, alarm status) generated by 

the terminal before running the application, select Yes. The files are 
deleted from the system default location.

• To retain all log files, select No.

6. To return to the previous dialog box, press OK.

7. To return to terminal settings, press OK.
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Configure Controller Address You can configure communication information for your application and 
controller by using RSLinx Enterprise software.

To edit the device address of the controller, follow these steps.

1. Press Terminal Settings, then choose Networks and 
Communications>RSLinx Enterprise Communications.

2. Select the controller in the tree.

3. To view the device name and current address, press Edit Device.

4. To modify the address, press Device Address.

The input panel opens with the current address.

5. Enter the address in the input panel and press Enter.

6. Press OK.

Updates do not take effect until the terminal is restarted.

Configure Ethernet Settings The terminal has a built-in Ethernet driver. You can modify the Ethernet 
information for your device:

• IP address of terminal on network including link speed
• Device name that identifies terminal on network
• User name and password to access network resources
• Enable or disable either Ethernet port to configure for DLR, star, or 

linear network topologies

TIP You can also configure communication information for your application and 
controller by using FactoryTalk View Studio software.
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Set the Ethernet Address of the Terminal

Some networks automatically assign an IP address to Ethernet devices if 
Dynamic Host Configuration Protocol (DHCP) is enabled. If DHCP is 
disabled, you can manually enter an IP address.

To view or enter an IP address for your terminal, follow these steps.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. To view or modify the IP address, press IP Address.

3. To enable or disable DHCP assignment of addresses, press Use DHCP.
• If DHCP is enabled or set to Yes, IP addresses are automatically 

assigned to newly attached devices on the network.
• If DHCP is disabled or set to No, you can manually enter the IP 

address. Press IP Address, Subnet Mask, and Gateway to enter IP 
formatted addresses.

4. Press OK when done.

If prompted, reset the device from the FactoryTalk View ME Station 
dialog box.

5. Press Close.

TIP • IP Address - The format of the IP address is xxx.xxx.xxx.xxx, for example, 
10.90.95.15. The first set of decimal numbers is in the range 1…255; 
the last three sets in the range 0…255. The default is 000.000.000.000. 

• Subnet Mask - Address must be identical to the server subnet mask. 

• Gateway - optional address.

• MAC ID - read-only field.
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Set the Ethernet Link Speed

You can change the rate and mode at which data is transmitted on the Ethernet 
network. The default setting is Auto. The Auto option automatically 
configures the speed of the device to match the speed on the local network.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. To access the Ethernet link settings, press Settings.

3. To change the rate at which data is transmitted over the Ethernet 
network, press Ethernet Configuration.

4. To return to the Network Adapters dialog box, press OK.

TIP The Auto option is preferred because it determines the actual speed and 
duplex setting of the connected device on the Ethernet network.

If you select a manual option, make sure that the speed and duplex setting 
for the connected device on the Ethernet network is identical. If the settings 
are different, there can be decreased network performance and errors.
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Define Name Server Addresses

You can define Name Servers addresses for the EtherNet/IP network adapter. 
These addresses are automatically assigned if DHCP is enabled for the adapter.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. Press Name Servers.

3. To enter a corresponding name server address, press a button.

4. Press OK when done.

Configure the Ethernet Ports

To configure the Ethernet ports of the terminal, follow these steps.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network Adapters.

2. To access the Ethernet link settings, press Settings.

3. To enable or disable the ports that you want to use for your network 
configuration, press Ethernet Link1 and Ethernet Link2.
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4. To select Auto, press Ethernet Configuration.

5. To save the configuration, press OK.

6. Restart the terminal for the changes to take effect.

You can also configure the Ethernet ports as a system default for a closed 
system. See Configure the Ethernet Ports on page 123.
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View the Network Diagnostic Data

To view the network data, follow these steps.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Network 
Adapters>Network Diagnostics.

The table provides a description of Network Status text.

2. Press Close to exit the Network Diagnostic data.

Status Text Description

Network Status

Normal If network topology is Linear/Star, the network status is always normal.

Ring Fault A non-fatal error condition exists.

Loop Detected This value can only occur in a Linear/Star topology. This status occurs when an 
unexpected loop occurs in the network. It may not be possible for the terminal to report 
this condition (the terminal may not be capable of detecting frames that it has sent).

Network Topology Identifies the network configuration as Linear/Star or Ring.
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Modify Device Name of 
Terminal

Each terminal has a unique name that identifies it on the network.

1. Press Terminal Settings, then choose Networks and 
Communications>Network Connections>Device Name.

2. To view or edit the default device name, press Device Name.

3. To modify the description for the device, press Device Description.

4. Press OK.

TIP The device name has 1…15 characters:

• First character must be an upper or lowercase letter a…z, A…Z.

• The other characters can be a…z, A…Z, 0…9, or - (hyphen).

TIP The description is a maximum of 50 characters. The default description is 
Rockwell Automation plus the device catalog number.
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Copy Files on Terminal You can copy FactoryTalk View ME application (.mer) files or font files 
between nonvolatile memory of the terminal and a USB drive, or SD card. 

1. Press Terminal Settings, then choose File Management>Copy 
Files>Copy Applications or Copy Fonts.

2. To select the location of the file you want to copy, press Source:
• Internal Storage - nonvolatile memory of the terminal.
• External Storage 1 - SD card that is loaded in card slot of terminal.
• External Storage 2 - USB drive that is loaded in USB host port of 

terminal.

3. Select a file that appears in the list for the selected storage area.

4. Press Destination on the same dialog box.

5. To select the storage location to copy the file, press Destination. 

The destination must be different than the source location.

6. To copy the selected file to the target location, press Copy.

If the file exists, you are asked if it is okay to overwrite the file. Respond 
by selecting Yes or No.

TIP FactoryTalk View ME Station software looks for .mer files in the folder
My Device\Application Data\Rockwell Software\RSViewME\Runtime\ 
and font files in the folder \Rockwell Software\RSViewME\Fonts\ .
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Delete Files from Terminal You can delete FactoryTalk View ME application .mer files or font files that 
reside in nonvolatile memory of the terminal, a USB drive, or an SD card.

1. Press Terminal Settings, then choose File Management>Delete 
Files>Delete Applications or Delete Fonts.

2. To select the storage location of the application or font file you want to 
delete, press Source:
• Internal Storage - nonvolatile memory of the terminal.
• External Storage 1 - SD card that is loaded in card slot of terminal.
• External Storage 2 - USB drive that is loaded in USB host port of 

terminal.

3. Select a file that appears in the list for the selected storage area.

4. Press Delete.

5. Select Yes or No when asked if you want to delete the selected 
application or font file.

Delete Log Files

You can delete log files, alarm history files, and alarm status files from the 
System Default location of the terminal. The application generates these files 
during runtime.

1. Press Terminal Settings>File Management>Delete Files>Delete Log 
Files.

You are asked to confirm the deletion of the files.

Do you want to delete all FactoryTalk View ME Station Log Files?

2. Select Yes or No.

Log files not in the System Default location are not deleted.
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Display Settings For the terminal display, you can change its brightness, configure the screen 
saver, or disable the screen cursor.

Adjust Display Intensity

You can adjust the intensity of the backlight in 10% increments from 0…100%. 
At 0%, the backlight is minimally visible. You can use the default intensity of 
100% or adjust the intensity for runtime operations.

1. Press Terminal Settings, then choose Display>Display Intensity.

2. To switch between Default intensity and Runtime intensity, press 
Startup Intensity.
• If you select Runtime, the start-up screens use the runtime intensity.
• If you select Default, the start-up screens us the default setting of 

100%.

3. To increase or decrease the intensity for runtime operations, press the up 
or down cursors.

4. To save changes, press OK.

Configure the Screen Saver

A screen saver image appears on the terminal display when no user activity has 
been sensed for a certain time. The default idle time is 10 minutes. You can 
adjust the idle time and intensity level of the screen saver, disable the screen 
saver, or disable the screen saver image.

1. Press Terminal Settings, then choose Display>Screen Saver.
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2. To change the idle period for activating the screen saver, press Screen 
Saver.

To disable the screen saver, select Disabled.

3. To increase or decrease the brightness intensity of the screen saver, press 
the up and down cursors.

4. To access the screen saver image setting, press Advanced Settings.
a. To disable or enable the current screen saver, press Screen Saver 

Image.
See Screen Saver on page 98 for details on how to change the screen 
saver image.

b. To return to the Screen Saver dialog box, press OK.

5. To exit and return to terminal settings, press OK.

Disable the Screen Cursor

The terminal has a screen cursor that you can disable or enable.

1. Press Terminal Settings, then choose Display>Cursor.

2. To disable or enable the cursor, press Enable Cursor.

3. To exit and return to terminal settings, press OK.
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Input Device Settings You can adjust settings for input devices that are used by the terminal including 
the keypad, touch screen, attached keyboard or mouse, and string entry popup.

Configure Keyboard or Keypad Settings

You can adjust settings for keys on the terminal or an attached keyboard.

1. Press Terminal Settings, then choose Input Devices>Keyboard/Keypad.

2. Press Repeat Rate to specify the number of times a key repeats itself per 
second when held down.

Valid values are 0, 2…30. Values are device-dependent for an attached 
keyboard, but typically the same.

3. Press Repeat Delay to select the time that elapses per second before a key 
is repeated.

Values are device-dependent. Unsupported values are dimmed.

4. Press OK when done.
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Calibrate the Touch Screen

To calibrate terminals with a touch screen, follow these steps. 

1. Press Terminal Settings, then choose Input Devices>touch 
screen>Calibration.

2. Follow the instructions on the screen.

When the calibration is complete, a message appears to indicate the 
measurement of new calibration settings.

IMPORTANT Use a plastic stylus with a minimum tip radius of 1.3 mm (0.051 in.) A 
stylus is more precise than a finger and also helps to protect the screen.

On This Type of Terminal: Do This:

Touch screen only • Press the screen to register saved data. 
• Wait for 30 seconds to cancel saved data and keep the current settings.

Keypad and touch screen • Press the Enter key to accept new settings.
• Press the Esc key to cancel and keep the current settings.

Carefully press and briefly hold stylus on the center of the target.
Repeat as the target moves around the screen.
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Set the Double-tap Sensitivity for a Touch Screen

You can set and test the sensitivity of both speed and physical distance between 
touch screen presses. 

1. Press Terminal Settings, then choose Input Devices>touch 
screen>Double Tap Sensitivity.

2. To set the sensitivity of touch screen presses, double-tap Set.

3. To test the sensitivity of touch screen presses, double-tap Test. 

The Test button reverses its foreground and background colors.

4. Press OK when done.

Change the Popup for String Entry

You can use a string popup for character input instead of the popup keyboard 
or input panel.

1. Press Terminal Settings, then choose Input Devices>String Popup.

2. To select the preferred method for character input, press Invoke pop-up 
character input instead of pop-up keyboard.

3. Press OK.

TIP The process is identical for setting and testing the sensitivity of mouse 
clicks. To adjust the sensitivity of mouse clicks, press Terminal Settings, 
then choose Input Devices>Mouse.
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Configure Print Options You can configure settings to print displays, alarm messages, or diagnostic 
messages from FactoryTalk View ME applications. The setup to print displays 
and messages is the same; advanced settings are different.

PanelView™ Plus 7 Performance terminals support selected printers. For a list 
of supported printers, go to https://rockwellautomation.custhelp.com and 
search the Knowledgebase for keywords ‘Printers Supported on PanelView 
Plus’.

PanelView Plus 7 Performance terminals support selected Canon, Epson, 
Hewlett-Packard, and Brother printers. Printer installation is plug-and-play. 
Supported printers are automatically mapped to appropriate driver. Printers 
that do not configure automatically to the appropriate driver can be installed 
manually. 

To access the print setup, follow these steps.

1. Press Terminal Settings, then choose a Print Setup> option:
• Alarm Print Setup
• Diagnostic Setup
• Display Print Setup

The Print Setup dialog box shows installed printers that are available to 
the FactoryTalk View ME application. The list of printers that shows 
depends on what printers you install.

The terminals are not shipped with pre-configured printers so initially 
the dialog box is empty. 

2. Select an installed printer.

TIP The printer you select must be in the control panel Printers applet.

A failed attempt to automatically install a printer is reported in the system 
event log.

A printer that does not install automatically can be installed manually by 
using the control panel in Windows Explorer.

https://rockwellautomation.custhelp.com
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3. To access these options, press Advanced Settings:
• Options to print displays include print orientation, draft mode, 

and color.
• Options to print diagnostic and alarm messages determine when to 

print messages that are sent to the network or USB port.

4. Press OK when done.

5. Press OK to return to terminal settings.

Print Messages After Default Value Example

Specified number of messages 60 messages When the queue has 60 messages, the messages 
are printed regardless of how long they have been 
in the queue.

You can change the number of messages.

500 messages or timeout period, 
whichever is first

168 hours (7 days) If the queue has 350 messages after 168 hours, 
the 350 messages are printed.

You can change the timeout period.

Specified number of messages or 
timeout period, whichever is first.

60 messages
168 hours (7 days)

If the queue has 60 messages after 24 hours, then 
the 60 messages are printed.
You can change the number of messages and the 
timeout period.

For example, the number of messages is set to 75 
and the timeout period is set to 48 hours.

• If the queue has 75 messages after 24 hours, 
then the 75 messages are printed before the 
set timeout of 48 hours.

• If the queue has 15 messages after 48 hours, 
the 15 messages are printed after the set 
timeout period.
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Configure Diagnostics You can log diagnostics to a remote computer for troubleshooting. 

To configure and forward diagnostics to a computer, follow these steps.

1. Press Terminal Settings, then choose Diagnostic Setup.

A list of diagnostic nodes appears.

The Remote Log destination forwards messages to a Windows computer that 
runs diagnostics. The IP address and port number identify the computer. 

Select Message Routing to access the following dialog boxes:
• Remote Log
• FactoryTalk View Diagnostics List

Each dialog box shows a list of message that can be sent to a destination. Cursor 
to a message, then press On/Off to enable or disable the message. Messages 
with checked boxes are enabled. Messages with cleared boxes are disabled. 

Audit Message Logging lets you log messages as Audit or Information.

TIP To access Remote Log or Message Routing setup, select the node 
then press Edit.

Field Description Valid Values

Address IP address of the remote Windows computer. xxx.xxx.xxx.xxx

Port The port that is used to communicate with the remote Windows 
computer. 

4445 (default)
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Check Integrity of 
Application Files

It is good practice to periodically check the integrity of the .mer application 
that is loaded in the terminal and the runtime files. Errors, warnings, and 
information messages are logged to a file. You can view the log and clear items 
from the log. 

1. Press Terminal Settings, then choose File Integrity Check.

2. Press either of the Enable options to disable integrity checks of the .mer 
application or the runtime files.

Integrity checks are automatically performed on the application .mer file 
and runtime files. If you disable either of these functions, the files are not 
checked and the log file is not updated.

3. To save changes, press OK.

To view the log generated by runtime files, follow these steps.

1. Press View Log from the File Integrity Check dialog box.

2. To display details for that event, select an event and press More Details.

3. To clear all details from the log, press Clear All.

4. To return to previous dialog box, press Close.

TIP Runtime files allow applications to run on the terminal. If the terminal is 
not functioning correctly, a review of the logs can identify an error in a 
runtime file.
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View and Clear the System 
Event Log

The System Event Log displays warnings, errors, and events logged by the 
terminal. The log provides a time stamp of when each event occurred and text 
that describes the event. If the event log is full when a new event occurs, the 
oldest entry is removed to accommodate the new event.

1. Press Terminal Settings>System Event Log.

2. To display details for the event, select an event and press More Details.

3. Press Clear All clear all events in the log.

4. Press Close.

Enable or Disable the Alarm 
Display

The terminal displays each alarm as it occurs in the alarm display or alarm 
banner. When the operator acknowledges the most recent alarm, the alarm 
display closes or remains open. The default is to close the alarm display. 

1. Press Terminal Settings, then choose Alarms.

2. Press “Close Alarm Display When Newest Alarm Acknowledged” to 
toggle between Yes or No. 
• Yes closes the alarm display when the newest alarm is acknowledged.
• No leaves the alarm display open when newest alarm is 

acknowledged. 

3. Press OK.
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Display System Information You can view terminal and firmware revision information for software that is 
installed on a terminal.

View Terminal Information

You can view the following read-only information:
• Total power on time in minutes
• Processor temperature
• Battery voltage and state
• Memory that is allocated and used
• Random access memory (RAM) memory usage during runtime

To view status information for your terminal, follow these steps.

1. Press Terminal Settings, then choose System Information>Terminal 
Information.

.

Processor temperature must be less than 90 °C (194 °F).

Battery voltage must be at least 2.75V DC.

IMPORTANT Over-temperature messages are recorded in the system event log:

• 85 °C (185 °F) issues a warning message.

• 90 °C (194 °F) issues an error message.

Battery State Description

GOOD Good battery condition.

FAILING Low battery. Replace the battery.

BAD Battery is missing or bad. Replace the battery.
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2. To view information about storage RAM, program RAM, and available 
nonvolatile memory, press Memory Allocation.

3. To return to previous dialog box, press Close.

4. To troubleshoot anomalies by showing RAM used by the application at 
runtime, press Runtime RAM Usage.

5. To return to the previous dialog, press OK.

6. Press Close until you return to terminal settings.
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View FactoryTalk View ME Station Information

You can view firmware and version information for components that are 
installed on your terminal and access technical support information.

1. Press Terminal Settings, then choose System Information>About 
FactoryTalk View ME Station.

2. To display the support telephone number and website, press Technical 
Support.

3. Press Close until you return to terminal settings.
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Time and Date Settings You can change the date, time, time zone, and regional settings for terminal 
operations.

Change the Time Zone on Terminal

You can view or modify the current time zone on the terminal. Time zones are 
installed with the operating system. Changing the time zone adjusts the current 
time and date to match the time zone.

The clock in the terminal records the time when files are created or modified 
on the terminal. You can change the time and time zone of the clock.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Time Zone.

2. To select a time zone, press the up or down cursor.

Daylight Saving Time is enabled for all time zones except Japanese, 
which does not, support daylight savings. The clock is adjusted 
automatically when Daylight Saving Time changes. 

3. Optionally, press Daylight Savings to enable or disable Daylight Saving 
Time for a time zone.

Changes are not permanent until you close the Time Zone dialog box.

4. Press Close when done.

5. To return to the previous dialog box, press OK.

TIP Set the time zone before you change the current date and time on the 
terminal.
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Change the Current Date on Terminal

To adjust the date on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Date.

2. To change the current values above the button, press Year, Month, and 
Day:
• Year is four digits in the range 1980…2099
• Month is in the range 1…12
• Day is in the range 1…31 and validated by month

3. Press OK when done.

Change the Current Time on Terminal

To adjust the time on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Time.

2. To change the current values, press Hour, Minute, and Seconds:
• Hour range is 0…23 (24-hour format)
• Minute and second range is 0…59

3. Press OK when done.
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Regional Settings You can change the format to display dates, times, and numerics to match the 
standards of a country or region. Languages are installed with the operating 
system. Before changing regional settings, you must select a language.

To select a language that is installed on the terminal, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Language.

2. To select a language, press the up and down cursors.

3. Press OK.

The selected language shows under Current Language on the Regional 
Settings dialog box.

Change the Decimal Separator

You can change the decimal separator that is used in numeric formats for the 
selected language. The default separator is a period.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Numeric Format.

The default separator is shown.

2. Enter a maximum of three characters for the new separator.

3. Press OK.
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Change the Time Format for a Language

To change the format of the time for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Time Format.

2.

The current time appears in the selected format.

3. To adjust the formats, press the appropriate selections.

The sample format changes as you make selections.

4. Press OK.

Field Description Example

Time Format
12 hour

h:mm:ss tt (default)
h = 12-hour time display, no leading zero
tt = AM or PM symbol

7:23:02 AM or 1:13:31 PM
11:43:59 AM

hh:mm:ss tt
hh = 12-hour time display with leading zero
tt = AM or PM symbol

07:23:02 AM or 01:13:31 PM
11:43:59 PM

Time Format
24 hour

H:mm:ss
H = 24-hour time display, no leading zero

7:03:42 or 1:13:32
23:43:59

HH:mm:ss
HH = 24-hour time display with leading zero

07:03:42 or 01:13:22
23:43:59

AM Symbol Characters to indicate AM. If the time format is set to 
a 12-hour time display (h:mm:ss tt or hh:mm:ss tt), 
you can modify the AM symbol. 

AM (default)
12 character max

PM Symbol Characters to indicate PM. If the time format is set to 
a 12-hour time display (h:mm:ss tt or hh:mm:ss tt), 
you can modify the PM symbol. 

PM (default)
12 character max

Separator Characters that separate fields in time format. : (default)
3 character max
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Change the Short Date Format for a Language

To change the short date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Short Date Format.

2. To change the short date format, press Format.

The date updates in the Sample area as you make changes.

3. To change the character between date elements, press Separator.

The separator can be three characters. The default separator is – or /. 

4. Press OK when done.

Change the Long Date Format for a Language

To change the long date format for the selected language, follow these steps.

1. Select Terminal Settings, then choose Time/Date/Regional 
Settings>Long Date Format.

2. To change the long date format, press Format.

The date updates in the Sample area as you make changes.

3. Press OK when done.
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Notes:
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Operating System Features The PanelView™ Plus 7 Performance terminals run the Windows CE 6.0 
operating system (OS) providing the following features:

• Command shell
• Command processor
• Console window
• Windows Explorer shell
• Common dialog box
• Control panel
• Network user interface
• Soft keyboard input panels
• PDF reader
• Mouse and touch screen support with right-click support.

• VNC server and client viewer

Topic Page

Operating System Features 89

Windows Explorer 92

Taskbar 92

Soft Input Panels 92

Windows Control Panel 93

Backup and Restore 94

Display Properties 97

Hardware Monitor 100

Logo Manager 102

User Accounts 104

Services 105

Network Server Configuration 106

System Information 121

Touch Properties 125

PDF Reader 126

TIP Touch the screen for 1 second or longer for a right-click.
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Application Support

The Windows CE operating system supports these applications:
• .NET Compact Framework, version 3.5 or later
• C++ libraries and runtimes 
• Component services DCOM/COM/OLE
• Message queueing MSMQ
• MSXML, version 3.0 or later
• Microsoft foundation classes (MFC) for devices, version 9.0 or later
• Active template library (ATL)
• ActiveSync
• Cabinet (CAB) file installer/uninstaller
• ToolHelp application programming interface (API)
• Error reports (generator, transfer driver, control panel)

Scripting Support

The Windows CE operating system supports these scripting features:
• Batch/Command (BAT and Cmd files)
• CS-Script
• JScript

Network Support

The Windows CE 6.0 operating system supports these network features:
• Winsock support
• Network utilities - ipconfig, ping, route
• Network Driver Architecture (NDIS)
• Windows Networking API/Redirector
• Wired Local Area Network, 802.3, 802.5

IMPORTANT The platform distributes two VNC client viewers:

• Vncviewer.exe is in the /Windows folder on the terminal 
desktop. You can deploy this viewer to a personal computer to 
connect, view, and control a PanelView Plus 7 Performance 
terminal.

• Another viewer on the terminal lets you establish a VNC 
connection between two PanelView Plus 7 Performance 
terminals. To access this viewer, choose Start>Programs>VNC 
Viewer.
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Server Support

The Windows CE 6.0 operating system supports these servers.

Extended Features

The PanelView Plus 7 Performance terminals support these additional desktop 
applications that are not available on the PanelView Plus 7 Standard terminals.

Table 22 - Windows CE 6.0 Server Support

Server Default 
State Description

Web server Enabled The web server delivers content, such as web pages, by using the HTTP 
protocol over the web. 

FTP server Enabled File Transfer Protocol (FTP) is a standard network protocol for exchanging files 
over the Internet (TCP/IP-based network). 

UPnP server Enabled Universal Plug and Play (UPnP) is a set of networking protocols that lets 
devices install and connect to a network.

File Server Disabled A network protocol that provides shared access to files, printers, serial ports, 
and miscellaneous communication between computers on a network.

VNC server Disabled Virtual Network Computing (VNC) is a graphical desktop sharing system that 
you can use to remotely control another computer. It transmits keyboard/
mouse events from one computer to another, over a network.

ViewPoint 
Server

Enabled A web server application that provides remote user access via a web browser 
to the FactoryTalk® View Machine Edition HMI application that is running on 
the terminal. ViewPoint software is a Rockwell Automation product.

Table 23 - Operating System with Extended Features

Icon Software Icon Software

Microsoft Internet Explorer 6 web browser 
with Silverlight 2

Microsoft Office 2003 PowerPoint file viewer 

– Adobe Flash Lite 3.1
ActiveX plug-in for Internet Explorer 6

Microsoft Office 2003 Word file viewer 

Microsoft Remote Desktop Connection Microsoft Office 2003 Excel file viewer 

Microsoft media player 6.4 and 7.0 OCX – Westtek JETCET PDF viewer 

Microsoft WordPad text editor – Image viewer
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Windows Explorer Use one of these methods to access Windows Explorer from the desktop:
• Open the My Device icon.
• Choose Start>Programs>Windows Explorer.

A few folders contain items specific to the PanelView Plus 7 Performance 
platform.

Taskbar From the taskbar, you can access the Start menu, device IP information, the 
current language and time, input panels, and open programs.

To turn the taskbar on or off, follow these steps:

1. Choose Start>Settings>Taskbar>Start Menu.

2. Clear or check the Auto Hide checkbox.

Soft Input Panels The operating system offers different input panels for entering data. You can 
access the input panels from the taskbar or the control panel. From the taskbar, 
click the input panel icon and choose the input panel (keyboard) that you want 
to use:

• CHT Chajei IM (Chinese)
• CHT Phonetic IM (Chinese)
• Keyboard (small keyboard)
• LargeKB (large keyboard)
• MS Kana IM ( Japanese)
• MS Roma IM ( Japanese)
• Hide Input Panel (closes the keyboard)

Folder Content

Application Data Contains FactoryTalk View Machine Edition application files.
Path: \Application Data\Rockwell Software\RSViewME

VFS (Virtual File System) Contains firmware files and backup/restore files for the current system image. 
Path: \VFS\Platform Firmware

TIP On touch screen terminals, touch the bottom of the display to recover the 
taskbar when in Auto Hide mode.

TIP The input panel icon changes depending on which input panel you select.



Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020 93

Windows Operating System Chapter 4

Windows Control Panel Applications in the Windows control panel let you view and configure system 
and terminal settings. For example, you can monitor hardware performance, 
perform a touch screen calibration, or adjust screen saver settings.

The language of the control panel applications is based on the language set for 
the operating system. English is the default.

Use one of these methods to access the control panel:
• Choose Start>Settings>Control Panel.
• Open My Device on the desktop, then double-click Control Panel. 

This chapter covers control panel applications specific to the terminal.

TIP Most terminal settings are also available in FactoryTalk View ME Station 
Configuration mode.

TIP From the View menu, you can change the size of the icons or see a brief 
description of each.

TIP Many control panel applications have scroll bars to allow you to view 
information on smaller displays.
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Backup and Restore The Backup and Restore application lets you back up the current system image 
on the terminal, then restore that image to the same terminal or other HMI 
devices. This function is useful if you want to copy the same system image to 
multiple HMI devices. 

A typical backup image includes the following items:
• File system
• Firmware image
• Windows registry
• Optional user configuration data

To include user configuration data in the backup image, click Advanced 
Network & Display Settings in the Backup & Restore dialog box.

Perform a Backup

To perform a backup, follow these steps.

1. Insert a USB drive or SD card into the appropriate slot on the terminal.

2. In the control panel, double-click the Backup & Restore icon.

TIP You can back up a system image to a USB drive or SD card. Rockwell 
Automation recommends using a USB drive or SD card with a minimum of 
1 GB of available space. For applications with a large file system, use a 
minimum of 2 GB of available space.

Table 24 - Advanced Network Display Settings

Setting Description

Ethernet Network • DHCP-enabled or fixed IP address
• Primary and secondary DNS
• Primary and secondary WNS
• Speed and duplex settings

USB network USB IP address and subnet mask, Gateway, DHCP-enabled or 
fixed IP address

Network Device name

Display • Display brightness
• Screen saver dimmer timeout
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3. Click the browse ... button on the Backup tab.

4. Select the target location for the back-up file:
• USB Storage if you use a USB drive
• Storage Card2 if you use an SD card
• Target folder if you back up the file to the terminal

5. Type a name for the back-up file. 

Back-up files have the .pvb file type.

6. Click OK.

7. Click Backup to start the process.

A progress bar shows the status of the operation. The backup can take a 
few minutes. You receive notification when the backup completes.

8. Click OK.

If a file exists, you are asked if you want to overwrite the current file.

9. To close the Backup & Restore dialog box, click Exit.

TIP To verify the .pvb file was successfully created, double-click My Device and 
select the target location for the backup. If the .pvb file was not successfully 
created, use a USB drive or SD card with more available space.

Rockwell Automation recommends using a USB drive or SD card with a 
minimum of 1 GB of available space. For applications with a large file 
system, use a minimum of 2 GB of available space.
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Restore a Back-up Image

To restore or clone a back-up image to a storage device, follow these steps.

1. Insert the USB drive or SD card into the appropriate slot of the target 
device.

2. In the control panel, double-click Backup & Restore.

3. Click the Restore tab.

4. To select the back-up file to restore, click the...browse button.

5. Select the location of the back-up file:
• USB Storage if you use a USB drive
• StorageCard2 if you use an SD card

6. Select the .pvb back-up file that you want to restore.

7. Click OK.

8. Click Restore.

The restore includes advanced network and display settings if you 
selected this option when performing the backup.

9. To start the restore, click Yes.
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The terminal starts the restore process, which takes few minutes.

When the restore completes successfully, the terminal restarts.

Display Properties Use Display Properties to control the desktop background image and 
appearance, the brightness of the backlight, and screen saver settings.

Desktop Background

The Background tab in Display Properties controls the background bitmap on 
the desktop. The default bitmap is ‘abclocknight’.

You can select another image from the pull-down menu or browse the system 
for a bitmap image. Custom images are in the \Windows folder.

IMPORTANT Do not remove the USB drive, SD card, or power off the terminal during a 
restore. These actions can corrupt the firmware.

If the restore fails, reset the terminal from the maintenance menu.

See Maintenance Mode Operations on page 160 for details.
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Desktop Appearance

The Appearance tab in Display Properties controls the visual style and colors of 
the desktop and other window elements.

Two custom schemes and images provide for day or night viewing. When you 
change schemes, you must also change the image on the background tab.

Backlight Intensity

You can adjust the intensity of the backlight in 10% increments from 0…100%. 
At 0%, the backlight is minimally visible. 

Screen Saver

The screen saver extends the life of the display. When the terminal is idle for a 
continuous period, the screen saver dims the backlight and displays a moving 
image. When deactivated, the display brightness returns to its normal level.

Scheme Desktop Color Background Logo

AB Day Blue abclocknight

AB Night Black ablclockday
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The Screen Saver tab in Display Properties lets you perform these actions:
• Change the idle timeout for the screen saver. The default is 10 minutes.

When the screen saver activates, the dimmer controls the backlight 
intensity. You set the brightness of the dimmer in range 0…100%. The 
default intensity is 10%. At 0%, the backlight is minimally visible.

• Browse the system for another screen saver bitmap. The default screen 
saver is SSFloat.bmp. Click Add or Remove to change screen saver 
bitmap. The system recognizes bitmaps in the \Windows folder.

• Disable the screen saver by clearing the ‘Start screen saver after’ 
checkbox.

Cursor

The Advanced tab in Display Properties lets you enable or disable the visible 
cursor that you see on the display. The cursor is visible by default.

Screen Rotation

The Advanced tab in Display Properties lets you rotate the screen on the 
terminal. The default is 0°.

After you change the screen rotation, you have to calibrate the Touch Screen.

1. Plug in a USB mouse to the terminal.

2. Restart the terminal.

3. Use the mouse to calibrate the Touch Screen.

4. See Calibrate the Touch Screen on page 73 for calibration details.
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Hardware Monitor The Hardware Monitor provides continuous voltage, and temperature, load 
information for the terminal.

Processes

The Processes tab in the Hardware Monitor shows all processes that are 
running on the terminal, and the memory usage of each process.

System Event Log

The System Event Log in the Hardware Monitor shows warnings, errors, 
events, and information.

The log provides a date and time stamp of each event, and text that describes 
the event. The maximum size of the log is 1 MB, approximately 4,000 records. 
If the log exceeds 1 MB, the oldest 512K of information is removed. You can 
perform these operations on the log file:

• Press Export Log to export the log file to a CSV file (*.csv) in the 
\Windows folder. The default file name is SystemLog.csv.

• To clear all events from the log, press Clear Log.
• To view more details on a selected event, press Details.
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Monitors

The Monitors tab in the Hardware Monitor provides continuous voltage, 
temperature, and load information for the terminal.

Battery Voltage

The Monitors tab gives a visual status and voltage reading of the battery for the 
real-time clock. The battery voltage updates at powerup, then every hour. 

An event is logged to the system event log for a low or depleted battery.

Temperatures

The Monitors tab gives a visual status and reading of the current temperature 
of the logic board. The temperature updates every ten minutes.

An event is logged to the system event log for a failed temperature sensor.

Table 25 - Battery Conditions

Condition Battery

Depleted Less than 2.0V indicates a dead battery or no power.

Low 2.0…2.74V

Normal 2.75V or higher

Table 26 - Temperature Conditions

Condition Logic Board

Low –

Normal 25…94 °C (77…201 °F)

High 95 °C (203 °F) and higher

IMPORTANT A high temperature condition causes an automatic restart attempt. Restart 
attempts continue indefinitely until the system is cool enough to resume 
normal operation. High temperature conditions are logged to the system 
event log.
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Logo Manager Use the Logo Manager to change the logo that appears on the splash screen at 
startup and the default screen saver image. The default splash-screen image is 
the Allen-Bradley logo (ablogo.bmp).

The logo can be a .bmp, .jpg, .gif, or .png image. A 90 x 90 pixel, 16-bit color 
image provides a good result.

Before applying the new logo, you can do the following:
• Preview the logo on the splash screen.
• Resize image to fit the fixed area of the splash screen.

To apply a new logo the splash screen and the screen saver, follow these steps.

1. Double-click Logo Manager in the control panel.

The Logo Manager opens with the current logo.

2. Click Load.

3. Select the location of the new image you want to load:
• A folder on the terminal.
• Storage Card2 - SD card
• USB Storage - USB drive

4. Select the image file to load.

5. Verify that the file type is correct.

6. Click OK.
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The new logo appears in the Logo Manager dialog box.

7. Check ‘Preview entire screen’ to view the logo on the splash screen.

If the logo is truncated or too small, check ‘Stretch/shrink image to fit’ 
to resize the logo to fit the area.

8. If satisfied with the preview, click Apply.

A dialog box confirms that the splash screen was updated. The default 
screen saver, ssfloat.bmp, is updated with the new image.

9. Click OK, then click Exit to close the Logo Manager.
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User Accounts User Accounts let you create NT LAN manager (NTLM) user accounts to 
authenticate client connections when using the FTP, web, and file servers. A 
user account consists of a user name and a password.

To add a user account, follow these steps.

1. Double-click User Accounts in the control panel.

2. In the user name field, type a name.

3. To clear the field and type a password, click in the Password field.

Asterisks display as you type the password.

4. Reenter the password in the Confirm pwd field.

5. Click Add User.

6. Click OK to acknowledge the new user account.

The new user name is added to the list.

TIP NTLM is the security protocol that provides authentication, integrity, and 
confidentiality to users on Windows operating systems. NTLM is still 
included to support Windows 2000, 2002, and 2003 server systems.
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7. Repeat steps 1 through 6 to add additional user accounts.

8. When done, click X to close the dialog box.

To remove a user account, follow these steps.

1. Select a name from the user name list.

2. Click Remove User.

3. To confirm the removal of the selected user account, click Yes.

The user account list is permanently deleted from the list.

4. To close the User Account Manager, click X.

Services The Services application shows servers the PanelView Plus 7 Performance 
platform supports. You can enable (start) or disable (stop) each server. 

The buttons are color-coded:
• Green indicates that the server is running and automatically started at 

system startup.
• Red indicates that the server is not running.

TIPU Users who are entered in authentication lists of FTP, web, or file server 
configurations are removed when user accounts are deleted.
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• Gray indicates that the server is not available on the platform.

To enable or disable a server, press the corresponding button and the color 
changes accordingly.

Network Server 
Configuration

The Network Server Configuration application configures settings for VNC, 
FTP, web, Kepware, and file server activities on an Ethernet network.

VNC Server Configuration

The terminal provides two VNC client viewers:
• Vncviewer.exe is in the /Windows folder on the terminal desktop. You 

can deploy this viewer to a personal computer to connect, view, and 
control a PanelView Plus 7 terminal. See these sections for details:
– VNC Connection Requiring a Password for View-only Operations 

on page 108
– VNC Connection with Separate Passwords for View and Control 

Operations on page 109
• Another viewer on the terminal lets you establish a VNC connection to 

another PanelView Plus 7 terminal. To access this viewer, click 
Start>Programs>VNC Viewer. See these sections for details:
– Establish a VNC Connection Between a Local Terminal and a 

Remote Terminal on page 112
– Close a VNC Connection to a Remote Terminal on page 114
– Make a New VNC Connection to a Remote Terminal on page 114
– Transfer Files Between a Local and a Remote Terminal on page 115
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The VNC Server tab in the Network Server Configuration dialog box 
configures settings for a client device to view or control the terminal over a 
VNC connection. 

TIP Click OK in the title bar of the dialog box to apply new settings. You are 
asked if you want to restart the service immediately.

Table 27 - VNC Server Parameters

VNC Parameter Description Default

General

View Only (no remote 
control)

Check this option to let users view terminal displays over 
a VNC connection.
If you uncheck View Only, users can control and view 
terminal displays over a VNC connection.
If security is disabled, users are not required to enter a 
password when connecting to the terminal.

Enabled for view only

Security

Enable security Check this option to require password protection for VNC 
connections to the terminal. Users must enter a valid 
password before viewing or controlling terminal displays.
If you enable security, you must supply a password for 
one of these parameters:
• Password - for control and view operations
• View-only password - for view only operations

Disabled (unchecked)

Password Specifies a password that a user must enter when 
establishing a VNC connection to control terminal 
displays. Select the box, then type a password in the field 
at the bottom of the dialog box. The password is a 
maximum of seven characters.
Password protection is required to control terminal 
displays if:
• View Only is unchecked (allows control access)
• Security is enabled

No password

View-only password Specifies a password that a user must enter when 
establishing a VNC connection to view terminal displays. 
Select the box, then type a password in the field at the 
bottom of the dialog box. The password is a maximum of 
seven characters.
TIP: If you uncheck the View Only parameter, you have 
control and view access to the terminal. With control 
access enabled, you can restrict one or more users to 
view-only access by providing a View-only password. 
View-only password protection is required to view 
terminal displays if security is enabled:
• View Only is checked or unchecked
• Security is enabled

No password
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VNC Connection Requiring a Password for View-only Operations

The default VNC configuration enables view-only access to the terminal 
without requiring a password. This configuration requires the VNC viewer 
that you copy from your terminal to a computer. 

To configure a VNC connection that requires a password to view terminal 
displays, follow these steps.

1. From the control panel, click Server Config.

2. On the VNC Server tab, check these items:
• View only (no remote control)
• Enable security

3. Select View-only password, then enter a seven-character password in the 
field that opens.

4. Click OK

5. Restart the server when prompted to apply new settings.

To launch a VNC connection to view terminal operations, follow these steps.

1. On your computer, choose Start>Programs>TightVNC>TightVNC 
Viewer.

2. Enter the IP address of your terminal and click Connect.

3. Enter the View-only password that is defined on the terminal and click 
OK.

TIP Copy vncviewer.exe, in the /Windows folder on the terminal, to your 
computer and install the TightVNC software.

TIP Click the network connection icon in the system tray to view the IP 
address of the terminal.
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The PanelView VNC Server opens the current view of the terminal on 
your desktop. You can view but not control terminal operations.

4. When finished, close the PanelView VNC Server.

VNC Connection with Separate Passwords for View and Control Operations

You can configure the VNC server to require separate passwords for view-only 
and control operations. This example uses the VNC viewer that is deployed to 
a computer to connect to the terminal.

To configure the VNC server to require a separate password for view-only and 
control operations, follow these steps.

1. From the control panel, click Server Config.

2. On the VNC Server tab, do the following:
• Clear View only (no remote control).
• Check Enable security.

3. Select Password, then enter a password for control privileges.

Passwords are a maximum of seven characters.

4. Select View-only password, then enter a password for view-only 
privileges.

5. Click OK, then restart the service when prompted to apply new settings.

TIP Copy vncviewer.exe, in the /Windows folder on the terminal, to your 
computer and install the TightVNC software.
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To launch a VNC connection to enable control of the terminal, follow these 
steps.

1. On your computer, choose Start>Programs>TightVNC>TightVNC 
Viewer.

2. Click Options.

3. Clear View only (inputs ignored).

4. Click OK.

5. Enter the IP address of your terminal and click Connect.

The Standard VNC Authentication dialog box opens.

TIP To launch a VNC connection on your computer that requires a 
password for view-only operations, see VNC Connection Requiring 
a Password for View-only Operations on page 108 and follow steps 
1 through 4.

TIPClick the network connection icon in the system tray to view the IP address of the 
terminal.
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6. Enter the control password that is defined on the terminal and click OK.

7. On your computer, perform some actions to verify that you have control 
of the terminal.

8. When finished, close the PanelView VNC Server.
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Establish a VNC Connection Between a Local Terminal and a Remote Terminal

To establish a VNC connection from a local terminal to a remote terminal, 
follow these steps.

1. Access the Windows desktop of the local terminal.

2. On the local terminal (viewer) desktop, choose Start>Programs>VNC 
Viewer.

3. Enter the IP address of the remote terminal that you want to connect to 
and click Connect.

A Status message displays while the connection is being made. The 
messages can cycle as the status changes.

The message ‘Please wait - initial screen loading’ can also display after 
the connection has been made and while the desktop of the remote 
terminal is loading.

After the screen has loaded, the desktop of the remote terminal displays 
on the local terminal. You can now access the features and functions of 
the remote terminal. 

TIP Select an IP address from the pull-down menu, or enter an IP 
address by using a USB keyboard or soft input panel (see Soft Input 
Panels on page 92).
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The white dotted line indicates the remote terminal and is only for reference (the dotted 
line does not actually appear on the local terminal).
Note the two Start buttons: circled in white is the remote terminal; circled in black is the 
local terminal.
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Close a VNC Connection to a Remote Terminal

To close a VNC connection between a local terminal and a remote terminal, 
follow these steps.

1. Establish a VNC connection from a local terminal to a remote terminal 
(see page 112).

2. On the local terminal, right-click PanelView VNC Server.
3.

4. Click Close.

The VNC connection to the remote terminal is closed.

Make a New VNC Connection to a Remote Terminal

To make a new VNC connection to another terminal, follow these steps.

1. Establish a VNC connection from a local terminal to a remote terminal 
(see page 112).

2. Click the New connection icon in the menu bar.

3. Enter the IP address of the new remote terminal that you want to 
connect to and click Connect.

The local terminal creates a VNC connection to the new terminal.

TIP Touch the screen for 1 second or longer for a right-click. 

TIP Click PanelView VNC Server to toggle between the remote terminal 
(server) and local terminal (viewer) views.

TIP Select an IP address from the pull-down menu, or enter an IP 
address by using a USB keyboard or soft input panel on the local 
terminal (viewer) (see Soft Input Panels on page 92).

Remote Terminal

Local Terminal
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Transfer Files Between a Local and a Remote Terminal

You can perform these tasks with the TightVNC File Transfer dialog box:
• Transfer files and folders between connected terminals
• Rename a selected file or folder
• Create a folder
• Delete a selected file or folder

To transfer files between the local terminal and the remote terminal, follow 
these steps.

1. Establish a VNC connection from a local terminal to a remote terminal 
(see page 112).

2. Click the Transfer files icon in the menu bar.

3. Select the folder or files that you want to transfer.

4. Click the upload (>>) or download (<<) files icon.

5. Click Yes.

6. Click Refresh to view the change (in needed).

Download selected files from the remote 
terminal to the local terminal.

Upload selected files from the local terminal 
to the remote terminal.

Indicates the current 
directory level.

Double-click the arrow to move 
up one directory level.

Message field that records 
actions and errors for the 
current VNC session.

Rename = opens a dialog box where you can rename the selected file or folder.
Mkdir = lets you create a folder.
Remove = deletes the selected file or folder.
Refresh = updates the view.
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Web Server Configuration

The web server tab in the Network Server Configuration application 
configures settings that are used for HTTP web activities. These parameters 
are standard Microsoft Windows CE parameters.

TIP Click OK in the title bar of the dialog box to apply new settings. You are 
asked if you want to restart the service immediately.

Table 28 - Web Server Parameters

Parameter Description Default

Admin Users Specifies a list of users who are allowed to administer 
web activities. 
When selected, enter a list of user names, which are 
separated by semicolons, in the field that opens at 
the bottom of the dialog box.

ADMIN

Basic Authentication Check this option to require a user name and 
password to access the web server.

Disabled (unchecked)

Default Web Page Specifies default web pages that users can access. default.htm; index.htm

Allow Directory Browsing Check this option to let users browse directories on a 
web server. 

Disabled (unchecked)

Max Connections Specifies the maximum number of incoming web 
connections.

256

Log File Directory Specifies the path where the log file is stored. This file 
logs web activity. 

\windows\www

Max Log Size Specifies the maximum size of the log file that is 
stored in the log file directory.
A new log file is created, when the current log file 
reaches its maximum size. 

32768 bytes

NTLM Authentication Check this option to require a valid user name and 
password to access the web server.
If NTLM Authentication is enabled, you must enter a 
valid user name in the Admin Users field. 
NTLM user accounts are defined in the User Account 
Manager of the control panel.

Enabled (checked)
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FTP Server Configuration

The FTP Server tab in Network Server Configuration defines settings that are 
used to exchange files over a network. These parameters are standard Microsoft 
Windows CE parameters.

TIP Click OK in the title bar of the dialog box to apply new settings. You are 
asked if you want to restart the service immediately.

Table 29 - FTP Server Parameters

FTP Parameters Description Default

General 

Default Directory Specifies a storage location on the terminal where users can transfer files. 
The directory that users come to when they first connect to the FTP server. 

\Temp\

Idle Timeout Specifies an idle period after which inactive control connections are closed during a data transfer. An FTP session 
requires one control connection, plus one data connection, during file transfers.
Without a timeout, the FTP server process can be left pending indefinitely if the corresponding client crashes without 
closing the control connection.

300 seconds 
(5 minutes)

Debug Output Channels Specifies the number of debug output channels. 2

Debug Output Mask Specifies the port number of the output mask that is used for debugging. 23

Base Directory Specifies the path where the FTP log file and other support files are stored. \Windows

Log Size Specifies the maximum size of the file that logs FTP activities. The log file is stored in the base directory. 
A new log file is created, when the current log file reaches its maximum size. 

4096 bytes

Security Parameters

Use Authentication Check this option to require a valid NTLM user name and password to access the FTP server.
If authentication is enabled, you must enter one or more valid user names in the User List field. 
NTLM user accounts are defined in the User Account Manager of the control panel.

Enabled (checked)

Allow Anonymous Logins Check this option to let anyone connect to the FTP server. Anonymous logins do not require a user name and password. Enabled (checked)

Allow Anonymous Uploads Check this option to let users logged on anonymously to upload (or write) files to the FTP server (or default directory).
If unchecked, users that are logged on anonymously can download (or copy) files from the server.

Disabled (unchecked)

Allow Anonymous VRoots Check this option to let users logged on anonymously to access virtual roots. Disabled (unchecked)

User List Specifies the NTLM users that can access the FTP server and exchange files to or from the default directory.
When selected, you can enter a list of NTLM user names, which are separated by semicolons, in the field that opens at 
the bottom of the dialog box. User names and passwords are defined in the User Account Manager of the control panel.

None
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FTP Anonymous Login and Upload

With the default FTP security options, you can log on anonymously to the 
terminal and copy files between your computer and the default FTP folder on 
the terminal. 

To establish an FTP connection to the terminal by using anonymous logins 
and file transfers to and from the FTP folder, follow these steps. 

1. On your computer, open the web browser or any folder.

2. To determine the IP address of your terminal, click the Network 
Connection icon in the system tray.

3. Type the terminal IP address in the address field. 

A connection is established to the \Temp folder, the default FTP 
directory on the terminal. The terminal shows two files.

If you launch the FTP connection from your web browser, this view can appear.

To see the folder view, choose Open FTP site in Windows Explorer from the 
Page pull-down menu.

TIP If Allow Anonymous Uploads is unchecked, you can copy files from the 
default FTP folder on the terminal but not to the folder.

EXAMPLE Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.

For example, ftp://192.168.124.96
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4. Transfer files between your computer and the FTP folder on the 
terminal:
• Drag or copy a file from the FTP folder to your computer.
• Drag or copy a file from the computer to your FTP folder.

FTP Connection Requiring User Authentication

You can require a user name and password before establishing an FTP 
connection. On the FTP Server tab, check Use Authentication. Select User 
List and enter a valid user name in the field that opens at the bottom of tab.

To establish an FTP connection to the terminal by first entering a valid user 
name and password, follow these steps. 

1. On your computer, open any folder or the browser.

2. Determine the IP address of your terminal by clicking the Network 
Connection icon in the system tray.

3. Type the terminal IP address in the Windows Explorer address field.

4. Click OK if the FTP Folder Error dialog box appears.

5. From the File menu, choose Login As.

TIP You can create user names and passwords in the User Accounts application 
of the control panel. See User Accounts on page 104.

EXAMPLE Use this syntax for the IP address:
ftp://ipaddress_of_the_terminal.

For example, ftp://192.168.124.96

TIP The user name must be in the User List of the FTP configuration and 
previously configured as a valid account in the User Accounts 
application. 
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6. Type a valid user name and password.

7. Click Log On. 

The default FTP directory on the terminal opens. You can transfer files 
to or from this folder.

File Server

The File Server tab in Network Server Configuration has settings that allow 
shared access to files, printers, serial ports, and miscellaneous communication 
between computers on a network. These parameters are standard Microsoft 
Windows CE parameters.

TIP Click OK in the title bar of the dialog box to apply new settings. You are 
asked if you want to restart the service immediately.

Table 30 - File Server Configuration

Parameter Description Default

General

Adapter List Provides a list of valid adapters. * (all adapters)

Max Printer Swap Size Specifies the maximum size of the printer swap file. 4096 bytes

Security Options

Use Authentication Check this option to require a valid NTLM user name and 
password to access the file server.
If authentication is enabled, you must enter one or more 
valid user names in the User List field. 
NTLM user accounts are defined in the User Account 
Manager of the control panel.

Disabled (unchecked)

User List Specifies a list of valid NTLM users who are allowed to 
access the file server. 
When selected, you can enter a list of NTLM user names, 
which are separated by semicolons, in the field that 
opens at the bottom of the dialog box. User names and 
passwords are defined in the User Account Manager of 
the control panel.

None
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KEPServer Configuration

The Kepware Server tab in Network Server Configuration lets you select 
Kepware communication drivers for connected devices.

System Information The System Information application provides tabs to view and set system-wide 
properties for your terminal. 

General Information

The General tab of System Information shows the current version of the 
Windows CE operating system, the processor type, speed, and available 
memory.

Startup Options

The Startup Options tab of System Information lets you set these start-up 
options:

• Show or hide the battery warning
• Launch the terminal as open or closed
• Configure the Ethernet ports for DLR, star, or linear topology

TIP For a complete list of Kepware drivers, go to
http://www.rockwellautomation.com/knowledgebase and search the 
Knowledgebase for keywords ‘Kepware Drivers for PanelView Plus’.

IMPORTANT Click OK in the title bar to apply new settings. You are asked if you want to 
restart the service immediately. You must also restart the terminal.

https://rockwellautomation.custhelp.com/
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• Disable or enable Safe mode
• Show or hide system watchdog errors

Battery Warnings

If the battery is low, missing, or depleted, a 
warning appears each time that the terminal 
starts up.

You have three options for handling the 
battery.

Startup Options

Use the Shell options to launch an open or closed desktop at startup and to set 
the visual appearance of button controls.

TIP• The terminal can operate without a battery if the 
accuracy of the date and time is not critical. 

• When replacing the battery, you can verify the 
accuracy of the system date and time from the 
desktop control panel or the terminal settings in 
FactoryTalk View ME Station.

Battery Warning Startup Options Description

Always show at startup (continue with startup) Shows the battery warning at startup with FactoryTalk View 
ME Station software running behind it (default). 

Always show at startup (halt startup) Shows the battery warning at startup but halts the startup or 
boot process until you press OK. 

Never show at startup Hides the battery warning at startup.
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Boot Option

The boot options provide a way for you to enter Safe mode at startup.

Configure the Ethernet Ports

The ‘Network (On-board Embedded Ethernet Switch - DLR)’ provides 
options to configure the on-board Ethernet switch of the terminal for the 
network topology. You can also configure the Ethernet ports from the terminal 
menus. See Configure the Ethernet Ports on page 64.

After changing the selections, restart the terminal.

Shell Startup Options Description

Type Launches the terminal as an open or closed system at startup:
• (Open system) – launches the Windows CE desktop on startup.
• (Closed system) (default) – launches FactoryTalk View ME Station 

Configuration mode on startup.
You can also allow or restrict desktop access within FactoryTalk View ME 
Station Configuration mode by pressing Terminal Settings>Desktop Access 
Setup. See Desktop Access on page 54.

User Interface Button Controls Sets the visual appearance of control buttons at startup:
• Windows XP Style (default)
• Windows 95 Style

Safe Mode Options Description

Do not detect Safe mode 
request at startup

Disables Safe mode detection during startup (default).

Detect Safe mode request at 
startup

Displays a small white box in the lower left corner of the terminal display during 
startup. Press and hold the white box to enter Safe mode. Safe mode lets you 
bypass a loaded FactoryTalk View ME application and go directly to Configuration 
mode. If you do not press the white box, the system boots up normally.
Another way to enter Safe mode is to access Maintenance mode. 
See Maintenance Mode Operations on page 160.

Port (Link) Configuration Description

Port 1 (Link 1) and Port 2 (Link 2) Enabled Enables Link 1 and Link 2 Ethernet connections for DLR 
configuration.

Port 1 (Link 1) Only Enabled Enables Link 1 Ethernet connection for star or linear configuration.

Port 2 (Link 2) Only Enabled Enables Link 2 Ethernet connection for star or linear configuration.
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Watchdog Errors

You can show or hide watchdog errors at startup.

Advanced Diagnostics

Advanced diagnostics are for technical support use to diagnose and resolve 
system errors. They are not for use in a normal production environment.

Device Name

The Device Name tab of System Information identifies your terminal to other 
devices on the network by providing a device name and description.

Watchdog Error Options Description

Always show watchdog errors at startup Shows the fatal watchdog error (error 02) at startup and halts 
the normal boot process (default).
The system launches the maintenance window with the 
watchdog error displayed. You can continue booting from this 
window. See Maintenance Mode Operations on page 160 for 
details.
The error is logged to the System Event log.

Never show watchdog errors at startup Hides the errors at startup and adds the error to the system 
event log.

TIP Device names must be unique. Duplicate names conflict and cause network 
problems.
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Touch Properties Touch Properties is accessible on devices with a touch screen. It lets you 
calibrate the touch screen and set the sensitivity of touch screen taps.

Calibration

The Calibration tab lets you recalibrate the touch screen if your device is not 
responding appropriately to taps. Follow the instructions in the dialog box to 
recalibrate.

Double-tap

The Double-Tap tab lets you set and test the double-tap sensitivity of the touch 
screen taps.
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PDF Reader The PDF reader provides typical view and search functions. You can run this 
reader from the Windows desktop or a command prompt.

When viewing a PDF document, you can initiate functions from the menu or 
toolbar. Bookmarks created in the original PDF appear under bookmarks.

Figure 8 - PDF Reader Workspace

Some viewing functions can be initiated on touch screen terminals by touching 
or dragging.

3/32

Page 
Navigation

Zoom 

Rotate

Search

Bookmarks Page Navigation
Slide BarOpen

Current Page 

Magnified view of page with minimap. You can 
touch the gray areas on the minimap to view 
another area of page at the same zoom level.

Prev/Next

Table 31 - Touch Screen Operations 

To Do This Indicator

Zoom In or Out Tap the screen once to zoom in.
Tap the screen again to zoom out.
If Menu>View>Minimap is chosen, a miniview of the page appears in lower right of 
workspace. You can tap the gray areas to change view.

Navigate pages • Drag your stylus or finger to the right or left to view next and previous pages.
An indicator shows the direction your are dragging.
A box shows the current page/total page count.

• Drag up or down the screen to activate the page navigation bar on the right.
Move slide bar up or down to navigate pages.

See page 
navigation bar in 
Figure 8.

Rotate Drag in a circular, clockwise or counterclockwise direction to rotate the page.

3/32
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Command Prompt Parameters

To run the PDF reader from the Windows Command Prompt, choose 
Start>Programs>Command Prompt, and execute the command parameters in 
Table 32.

Command Prompt Syntax

Foxitreader “file_path/file-name.pdf” parameter parameter_ value

• Enclose the file path and file name in double quotes and use forward 
slashes to separate the file path directories and file name.

• Use spaces to separate the parameter from the file name and optional 
parameter value.

Command Prompt Example

Foxitreader “windows/desktop/example.pdf” -p 4

This command prompt opens example.pdf in Foxit Reader at page 4.
Table 32 - Command Prompt Parameters

Parameter Parameter Function Example Description

-p Go to page Foxitreader “file_path/file.pdf” -p 2 Opens the PDF file to page 2.

-zw Fit width Foxitreader “file_path/file.pdf” -zw Opens the PDF file and fits the view to the page width.

-zp Fit page Foxitreader “file.pdf”-zp Opens the PDF file and shows the full page.

-z Zoom to Foxitreader “file.pdf”-z 150 Opens the PDF file and zooms to 150%.

Multiple parameters Enter empty spaces between 
parameters and parameter values

Foxitreader “file_path/file.pdf” -p 2 -zw Opens the PDF file to page 2 and fits the view to the 
page width.

-b Go to bookmark Foxitreader “file_path/file.pdf” -b “Bookmark1” Opens the PDF file to the location specified within 
Bookmark1.

-d Go to named destination Foxitreader “file_path/file.pdf” -b “Destination1” Opens the PDF file to the location specified within 
Destination 1.

-g Disable the File>Open command on 
the Menu and the Open folder button.

Foxitreader “file_path/file.pdf” -g Opens the PDF file and dims the Menu, File>Open 
command and the Open button.
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Notes:
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Install and Replace Components in the ArmorView Plus 7 
Performance terminal.

See the ArmorView Plus 7 Installation Instructions, 
publication 2711P-IN013.

ATTENTION: Prevent Electrostatic Discharge (ESD)
This equipment is sensitive to electrostatic discharge, which can cause internal 
damage and affect normal operation.

Follow these guidelines when you handle this equipment:

• Touch a grounded object to discharge potential static.

• Wear an approved grounding wriststrap.

• Do not touch connectors or pins on component boards.

• Use a static-safe workstation, if available.

ATTENTION: Disconnect all power before installing or replacing any 
components. Failure to remove power can result in electrical shock or 
damage to the terminal. 

At the end of its life, this equipment should be collected separately from any 
unsorted municipal waste.

TIP For a complete list of supported devices, go to
https://rockwellautomation.custhelp.com and search the Knowledgebase 
for keywords ‘PanelView Plus Hardware Compatibility List’.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
https://rockwellautomation.custhelp.com
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Connect to USB Ports The terminals have two USB 2.0 (type A) host ports. The USB host ports 
support removable USB drives and a USB printer.

Icons identify the USB host connections. The USB host connection supports 
0.5 A at 5V DC. Connected USB devices must not exceed this power load. 

IMPORTANT See Required Circuit Port Parameters for USB Peripheral Devices on 
page 26 for information on how to use the USB host ports and USB 
peripheral devices in hazardous locations.

IMPORTANT The USB host connections are intended for temporary use. Do not use the 
USB host connections for runtime operations. 

Table 33 - USB Connector Pinout

USB Port USB Icon USB Connector Pin Signal Description

Host 1 VCC +5V

2 D- Data -

3 D+ Data +

4 GND Ground

WARNING: USB devices that are not powered by the USB port must be 
within the same enclosure as the terminal. The USB devices must be 
connected to a ground system common with the terminal or used with a 
USB hub that provides galvanic isolation.

1 1

Two USB Host Ports

Performance Terminals

Stainless Steel Terminals

IMPORTANT: The USB 
device port is not 
functional. Do not 
use this port.
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Connect only externally powered USB hubs to the terminal that are USB 2.0 
compatible. Before you attach devices to a USB hub, make sure that the power 
adapter is connected and powered on.

USB Cables

Use only hi-speed, USB 2.0 certified cables for error-free transmissions. 

Install a USB Printer The terminal supports the connection of one USB printer such as Canon, 
Epson, Hewlett-Packard, and Brother. The printers support plug-and-play 
installation and manual installation if a suitable driver is available. You can 
connect a printer to a USB port on the terminal.

Printers are configured and managed from the Printers application in the 
desktop control panel. A wizard is supported for each printer type.

After configuring a printer, you can access it from desktop applications or from 
FactoryTalk® View Machine Edition Station. Press Terminal Settings, then 
choose Print Setup. Applications can also select and share printers.

TIP For more information on supported printers, go to
https://rockwellautomation.custhelp.com and search the Knowledgebase 
for keywords ‘Printers Supported on PanelView Plus’.

Table 34 - Support for Printers

Printer Type Description

Local USB You can connect a JETCET supported printer to a USB host port.
The printer that is attached to the USB host port can be shared by a remote terminal when 
configured as a network printer on the remote terminal. 

Network The terminal supports a remote printer that is connected to the network via the Ethernet 
port. The printer address can be its device name or IP address. 

RDP/ICA A local printer can be made available to a Windows server application that is running in an 
RDP (Remote Desktop Protocol) session on the terminal. 

https://rockwellautomation.custhelp.com
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Plug-and-Play Installation

To install a plug-and-play printer from the Windows desktop, follow these 
steps. For manual printer installation, see Manual Printer Installation on 
page 133.

1. Connect the printer to a USB host port on the terminal.

2. Plug the power cord of the printer into an outlet and turn on the printer.

Windows automatically detects your plug-and-play printer, and in most 
cases, without requiring you to make any selections.

The printer is ready to print.

3. Verify printer installation from the desktop control panel by opening the 

Printers application. 

Notice the icon for the Deskjet 5650C printer. The check mark 
indicates that this printer is the default.

4. From the File menu, choose Properties to view the properties of the 
printer.

Printer properties include the printer name, manufacturer and model, 
print driver, and port-specific parameters.

TIP This procedure shows a plug-and-play installation for the Hewlett Packard 
HP Deskjet 5650 printer.

IMPORTANT If automatic plug-and-play installation is not supported for a printer, this 
error is logged to the System Event log in the Hardware Monitor. 

For example, JETCET PRINT was unable to auto-configure printer. To manually 

configure printer, go to the Printers folder from the Control Panel.
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5. To verify installation, right-click the printer and print a test page.

When printing from an application such as WordPad, a Print dialog box opens 
where you can adjust settings.

Manual Printer Installation

To configure a supported printer, follow these steps.

1. Connect the printer to a USB port of the terminal.

2. Plug the power cord of the printer into an outlet and turn on the printer.

3. From the desktop control panel, open Printers .

4. Click Add Local Printer.

5. To configure the printer, follow the Add Local Printer Wizard 
instructions:
a. Verify that the connected printer appears on the USB printer port.
b. Select the manufacture and model of the JETCET printer.
c. Accept the default printer name or enter another.
d. To verify the installed printer, print a test page.
e. Specify whether you want the printer to be shared on the network.

TIP • New printer configurations are retained through a power cycle.

• Printers that are configured through the desktop control panel are also 
available within FactoryTalk View ME Station when pressing Terminal 
Settings>Print Setup.
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Insert an SD Card An SD card provides extra storage when inserted into the SD card slot of the 
terminal. Supported cards include catalog numbers 1784-SD1, 1784-SD2, 
1784-SDHC8, and 1784-SDHC32. The SD cards are hot-swappable; they 
can be inserted and removed while the terminal is powered on and running.

The SD card slot is accessible from the inside or back of the panel when the 
operator terminal is installed. 

To install an SD card in the card slot, follow these steps.

1. Verify that the SD card is locked or unlocked according to your 
preference. 
• If unlocked, the terminal can write data to or read data from the card.
• If locked, the terminal can only read data from the card.

2. Insert the SD card firmly into 
the slot until you hear a click.

When you hear the click, the 
card has locked into place.

To remove the card, push the 
SD card in slightly and 
remove then it from the slot.

WARNING: Explosion Hazard

If you remove or insert an SD card while the power is on, an electric arc can 
occur. This arc can cause an explosion in hazardous location installations.

Do not remove and insert the SD card unless power has been removed or the 
area is known to be nonhazardous.

ATTENTION:  Orient the SD card correctly before you insert the card 
into the slot. If you force the card into the slot, you can damage the 
card or the terminal.

Unlocked
Locked

1

6
1

6

SD Slot

The aluminum terminal is 
shown. The SD card location is 
the same on the stainless 
steel terminal.
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Connect a Speaker You can connect a speaker or audio amplifier to the terminal to announce 
alarms, provide feedback of operator actions, and provide sound during video 
playback. 

Selecting a Speaker for a Class D Amplifier

The audio port is a class D amplifier output. It has a two-pin terminal block for 
connecting a 4 ohm or 8 ohm speaker. The audio port can also drive externally 
amplified speakers.

TIP The speaker works in the Windows CE operating system (Windows Media 
Player). FactoryTalk View ME Station software does not support the 
speaker.

Speaker Impedance Ω Test Frequency (KHz) THD + N (%) Output Power (W)

4 1 1 2.2

4 1 10 2.7

8 1 1 1.3

8 1 10 1.6

ATTENTION: The audio port is nonisolated. Follow these guidelines:

• A connected speaker must be within the same enclosure as the terminal. 
Amplified speakers must be connected to a ground system common with 
the terminal.

• The audio is provided as a terminal block connection for use in hazardous 
locations. Connect and tighten wires securely. 

Table 35 - Audio Port Wiring

Wire Type Wire Size Strip Length Torque Min…Max

Stranded or solid
Cu 90 °C (194 °F)

0.05…1.3 mm2

30…16 AWG
5 mm (0.2 in.) 0.22…0.25 N•m

(1.95…2.2 lb•in)

1

6
1

6

Audio Out

+

+

+

––

+

The aluminum terminal is shown. The 
speaker connection is the same on the 
stainless steel terminal.
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Use a 0.4 x 2.5 mm screwdriver for terminal block wiring. The wire length must 
not exceed 1 m (39 in.).

To connect a speaker to the audio port, follow these steps.

1. Use wire strippers and remove about 5 mm (0.2 in.) of insulation from 
the ends of the wire. 

2. Attach one of the newly exposed wires to the positive (+) terminal and 
the other to the negative (–) terminal on the operator device.

3. Connect the opposite exposed ends of the wire to the positive (+) and 
negative (–) terminals on the speaker or amplified speakers.

Replace the Battery The product has a lithium battery that provides back-up power for the real-
time clock and static RAM. The battery can be replaced while the product is 
mounted in the panel. You need a #1 Phillips screwdriver (#1 Phillips bit) to 
remove the logic module and access the battery. 

Perchlorate material – special handling may apply. See www.dtsc.ca.gov/
hazardouswaste/perchlorate.

This perchlorate warning only applies to primary Lithium Manganese Dioxide 
(LiMnO2) cells or batteries, and products containing these cells or batteries, 
sold or distributed in California, USA.

This product contains a sealed lithium battery that may need to be replaced 
during the life of the product.

At the end of its life, the battery contained in this product should be collected 
separately from any unsorted municipal waste.

The collection and recycling of batteries helps to protect the environment and 
contributes to the conservation of natural resources as valuable materials are 
recovered.

ATTENTION: There is a danger of explosion if the lithium battery or real-
time clock module in this product is incorrectly replaced. Do not replace the 
battery or real-time clock module unless power has been removed and the 
area is known to be nonhazardous. 

Replace the battery only with catalog number 2711P-RY2032 or an equivalent 
CR2032 coin-cell battery.

Do not dispose of the lithium battery or real-time clock module in a fire or 
incinerator. Dispose of used batteries in accordance with local regulations.

For safety information on the handling of lithium batteries, including handling 
and disposal of leaking batteries, see Guidelines for Handling Lithium Batteries, 
publication AG 5-4.

http://literature.rockwellautomation.com/idc/groups/literature/documents/td/ag-td054_-en-p.pdf
www.dtsc.ca.gov/hazardouswaste/perchlorate
www.dtsc.ca.gov/hazardouswaste/perchlorate
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To replace the battery, follow these steps.

1. Remove power from the terminal.

2. Loosen the screws that secure the logic module to the back of the 
display.

3. Carefully lift the logic module away from the display module and turn 
over to expose the circuit board.

4. Locate the coin-cell battery on the circuit board.

5. To remove the battery, lift the side of the battery.

6. Insert the new battery with the positive (+) polarity up.

7. Reattach the logic module by aligning the connector on the bottom of 
the logic module with the connector on the back of the display module.

This equipment is sensitive to Electrostatic Discharge (ESD).
Follow ESD prevention guidelines when handling this equipment.

Logic Module

Display Module

The aluminum terminal 
is shown. Battery 
replacement is the 
same on the stainless 
steel terminal.
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8. Push down on the logic module and make sure it is fully seated.

9. Tighten the screws to a torque of 0.68…0.90 N•m (6…8 lb•in).

Install a Protective Overlay

The overlay helps to protect the touch screen and keys from scratches, dust, 
fingerprints, and external damage from chemicals or abrasive materials. See 
Table 6 on page 20 for a list of available overlays.

The protective overlay covers the entire 
surface of the terminal bezel inside the 
aluminum perimeter. The overlay has a 
protective liner that is removed by pulling 
back on a tab. Do not remove the liner until 
you are ready to install the overlay. 

Before installing the overlay, use a lint-free 
cloth and a mild glass cleaner to clean the 
touch screen surface, and keys, if present. 
Remove all fingerprints, grease, or dust. Marks that are not removed are 
trapped underneath the overlay. Grease also affects the adhesion of the overlay.

To apply the protective overlay, follow these steps.

IMPORTANT Do not use protective overlays with the stainless steel terminals. The 
protective overlays are not compatible in hygienic applications. 

The 12-inch overlay may be used on an ArmorView Plus 7 terminal, but it 
will only fit the touchscreen portion of the product.

IMPORTANT Follow these guidelines when installing the overlay:

• Make sure that your hands are clean and dry.

• Handle the overlay by its edges to prevents fingerprints or lint. If you 
do get marks or lint on the overlay, remove them before proceeding. 

• Do not touch the adhesive ring.
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1. Pull the tab from one of the short sides and partially peel the liner away 
from the adhesive layer.

Hold the peeled back portion of the protective liner out of the way as 
you perform the next step.

2. Center the overlay over the bezel and carefully position the adhesive 
surface on the terminal.

While the protective liner is still covering the rest of the overlay, verify 
that it is properly centered.

3. Slowly peel off the rest of the liner while using a soft cloth to press the 
overlay on the screen.

Make sure that the overlay lies flat with no bubbles or warps.

4. With a soft cloth or finger, press around the edges of the overlay to seal 
it, and remove any air bubbles trapped in the adhesive.

Clean the Overlay

Use a clean, lint-free cloth, and a mild glass cleaner that leaves no streaks to 
clean the overlay. Windex or an eye glass cleaner is recommended. Do not use 
cleaners that contain abrasives.

Remove the Overlay

Remove the overlay if it is damaged or needs replacement. Lift a corner and 
slowly pull off the overlay. Use isopropyl alcohol to remove any residual 
adhesive. Do not reuse the overlay.

Tab

Adhesive Ring

Protective liner
(covers adhesive)

Overlay

Bezel

Protective Liner



140 Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020

Chapter 5 Install and Replace Components

Replace the Stainless Steel 
Terminal Gasket

The hygienic gasket for the stainless steel terminal is blue.

To replace the stainless steel terminal gasket, follow these steps.

1. Remove power from the terminal.

2. Label all wiring and connections so you can attach them correctly later.

3. Remove all wiring and connections.

4. Remove the mounting clips and backing plate.

Hold the terminal so it does not fall out of the panel.

5. Remove the terminal from the panel.

6. Place the terminal screen-down on a clean, flat surface.

Be careful not to scratch or damage the terminal screen.

7. Remove the old gasket from the bezel.

8. Clean any dirt or residue from the bezel.

9. Position the new gasket on the bezel, with the gasket alignment plugs 
facing the bezel alignment features.

This gasket forms a compression seal. Do not use sealing compounds.

IMPORTANT Slip the inside corners of the gasket 
under the corners of the bezel 
shroud.

Backing Plate

Mounting Clips

Panel
Terminal
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10. Press each gasket alignment plug into the bezel alignment feature.

The alignment plugs hold the gasket to the bezel.

11. Place the terminal in the panel cutout.

Hold the terminal so it does not fall out of the panel.

12. Position the backing plate over the terminal.

13. Slide the ends of the mounting clips into the slots on the terminal.

IMPORTANT Make sure that the flat side of the backing plate faces away from the 
panel, as shown in the drawing.

Gasket with Alignment Plugs
Back of Bezel with Alignment Features

Panel

Terminal

Backing Plate

Mounting Clips

Panel
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14. Tighten the mounting clip screws by hand until the backing plate 
contacts the panel uniformly.

15. Torque the mounting clip screws to 2.3…2.6 N•m (20…23 lb•in) by 
using the specified sequence. 

The clips will loosen as the adjacent clip is tightened.

16. Repeat step 15 until all the mounting clips are at the specified torque.

17. Reattach all wiring and connections.

ATTENTION: Tighten the mounting clips to the specified torque to provide a 
proper seal and to prevent damage to the product. Rockwell Automation 
assumes no responsibility for water or chemical damage to the product or 
other equipment within the enclosure because of improper installation.

9-in. Torque Sequence
8 Clips

12.1-in. Torque Sequence
10 Clips

1

2

3

4

5

6 7

8
2

3

49

10

7 6

85

1
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Terminal Firmware Firmware components are packaged as execute-in-place (XIP) regions in a 
System Code (SC) .img file. When the SC .img file is copied to the Virtual File 
System (VFS) on the terminal, the terminal XIP regions are updated and the 
terminal restarts automatically. These firmware components are affected 
during an update: 

• FactoryTalk® View Machine Edition Station software
• Communication protocols and drivers including Kepware drivers
• Windows fonts
• Windows CE components
• FactoryTalk components
• User extensions

A firmware update does not affect these terminal components or settings: 
• Windows registry
• File system including the FactoryTalk View Machine Edition 

application that is loaded(1) in the terminal
• Network parameters including the network device name, DHCP-

enabled and static(2) IP addressing, speed, and duplex setting
• Display settings
• Screen saver configuration
• Touch screen calibration

Topic Page

Terminal Firmware 143

Download Firmware Files 144

Firmware Upgrade Wizard 144

Upgrade Terminal Firmware from a Storage Device 145

Update Terminal Firmware Over the Network 149

(1) In some cases, the FactoryTalk View ME application can be missing after a firmware update.

(2) In some cases, static IP addresses have been changed to DHCP-enabled IP address after a firmware update.
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Download Firmware Files Download the appropriate firmware installation package from the Rockwell 
Automation website. The package is named:

PVP7_<terminal family>_x.xx-yyyymmdd.exe, where:

• <terminal family> is the terminal name
• x.xx is the FactoryTalk View ME software version that is contained in 

the package
• yyyymmdd is the date that the package was created

This installation package contains the following:
• Firmware Update Package (FUP) contains an autorun executable and 

the new firmware files.
• Firmware Upgrade Wizard (FUW), version 6.10 or later, is used to 

update the terminal firmware by using the contents of the FUP.

The FUP and FUW are copied to your computer during the download. 

To download firmware installation files to your computer, follow these steps.

1. Click http://ab.rockwellautomation.com and choose Compatibility 
and Downloads. (See Product Firmware and Release Notes on page 8.)

2. Click the Get Downloads tab.

3. Click Find Product Downloads.

4. From the All Families pull-down menu, choose PanelView™ Plus 7 
Performance terminal.

5. Select a firmware revision, then click Find Downloads.

6. Download the update file (.exe) to a temporary folder on the 

same drive as FactoryTalk View Machine Edition (ME) software.

7. Run the update file (.exe) installation procedure: 
• The FUW is installed in the FactoryTalk View ME folder. 
• The firmware update package file (.fup) is installed into the folder 

that is specified during the installation procedure.

You are now ready to run the FUW to update the terminal firmware from a 
USB drive or SD card or by using a network connection.

Firmware Upgrade Wizard The Firmware Upgrade Wizard (FUW) is used to update the terminal 
firmware. Two methods are provided to update the firmware:

• Create a firmware update card with the contents of the FUP file that you 
can then load in the terminal to update the firmware. 

The firmware update card can be a USB drive or an SD card, catalog 
number 1784-SDx.

TIP The FUP name is ME_PVP7xX_6=8.xx-yymmdd

• yyyymmdd is the date the firmware package was created

• 8.xx is the version of ME contained in this package

http://ab.rockwellautomation.com
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• Update firmware in a terminal that is connected to a computer over a 
direct network connection. The network connection requires a 
computer running RSLinx® Enterprise software, version 5.0 or later. In 
the RSLinx Enterprise software, you select the terminal that you want to 
update.

You can run the FUW from within FactoryTalk View Studio software or from 
the Programs menu on your computer:

• In FactoryTalk View Studio software, from the Tools menu, choose 
Firmware Upgrade Wizard.

• Choose Start>Programs>Rockwell Software>FactoryTalk 
View>Tools>ME Firmware Upgrade Wizard.

Upgrade Terminal Firmware 
from a Storage Device

There are two steps to upgrade firmware from a storage device.

1. Create a firmware update card with the required firmware files.

2. To update the firmware, load the card in the target terminal.

The firmware update card can be a USB drive or an SD card.

Create a Firmware Update Card

To copy firmware files to a USB drive or SD card, follow these steps.

1. Insert either a USB drive or an SD card into the appropriate slot on your 
computer.

2. Run the Firmware Upgrade Wizard:
• In FactoryTalk View Studio software, from the Tools menu, choose 

Firmware Upgrade Wizard.
• Choose Start>Programs>Rockwell Software>FactoryTalk 

View>Tools>ME Firmware Upgrade Wizard.

3. Follow these steps from the initial Firmware Upgrade Wizard dialog 
box.



146 Rockwell Automation Publication 2711P-UM008H-EN-P - January 2020

Chapter 6 Update Firmware

a. Click Create firmware update card.

b. Select the location of the firmware card by browsing to the root 
directory of the storage card that is loaded in your computer, for 
example, E:\.
The firmware files are copied to this location. You can also specify a 
folder on the hard disk.

c. From the Existing terminal type pull-down menu, select a PanelView 
Plus 7 terminal.

d. Click Next.

4. Follow these steps from this dialog box.
a. Browse to the location of the firmware source files on your computer, 

where the FUP was installed.

b. Choose the firmware revision for the update.
c. Click Next.

It can take several seconds for the next dialog box to appear while the 
FUP is being retrieved.
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5. From this dialog box, optionally select the KEPServer drivers that you 
want included with the firmware, then click Next.

Kepware drivers are already installed on the PanelView Plus 7 
Performance terminals.

The final dialog box summarizes your choices for creating the firmware 
update card.

6. Click Finish to copy the firmware files to the firmware update card.

A progress bar automatically updates as files are copied to the USB drive 
or SD card. 

7. Click OK when the firmware update completes successfully. 

8. Remove the USB drive or SD card from your computer.

9. Go ahead to the next section to use this firmware update card to update 
the terminal firmware.

TIP If the firmware files were copied to the hard disk, copy the files 
to the root directory of the USB drive or SD card.
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Update Terminal Firmware by Using Firmware Update Card

To transfer firmware files from the USB drive or SD card to the terminal, 
follow these steps. Use the firmware update drive or card that you created in the 
previous section. 

1. Insert the USB drive or SD card into the appropriate slot on your 
terminal. 

The firmware update automatically starts and displays this dialog box.

2. To start the firmware update, press update or [F7] on the terminal.

The terminal restarts and displays a progress bar during the update. 

When the update is complete, the terminal restarts, and executes the 
new firmware.

3. Remove the USB drive or SD card from the terminal.

IMPORTANT For information on how to use a USB drive or SD card with the ArmorView 
Plus 7 terminal, see the ArmorView Plus 7 Installation Instructions, 
publication 2711P-IN013.

IMPORTANT • Do not remove or accidentally disconnect the USB drive or SD card 
while a firmware update is in process. This action can corrupt the 
firmware and make the terminal unstable.

• Do not power off the terminal during a firmware update.

• USB hubs can produce unexpected behavior and are not recommended. 

IMPORTANT If the firmware update fails because of a power loss or the firmware update 
card is inadvertently removed, you can restore the terminal to the factory 
default firmware. See Maintenance Mode Operations on page 160 for 
details on how to restore the factory default settings.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Update Terminal Firmware 
Over the Network

You can update firmware in a terminal that is connected to a computer over a 
direct network connection. The network connection requires a computer with 
the Firmware Upgrade Wizard (FUW) and RSLinx Enterprise software, 
version 5.0 or later.

RSLinx Enterprise software is required so that you can select the terminal on 
the network.

To copy firmware files to the terminal over a network by using RSLinx 
Enterprise software and Ethernet communication, follow these steps.

1. Run the Firmware Upgrade Wizard:
• In FactoryTalk View Studio software, from the Tools menu, choose 

Firmware Upgrade Wizard.
• Choose Start>Programs>Rockwell Software>FactoryTalk 

View>Tools>ME Firmware Upgrade Wizard.

2. Click update firmware on terminal and click Next.

3. Click Yes to continue.

It is not necessary to back up files on PanelView Plus 7 Performance 
terminals.
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4. Click ‘Network connection (using RSLinx Enterprise)’ and click Next.

This connection is the only valid selection for PanelView Plus 7 
Performance terminals.

5. Select the terminal for the firmware update.

6. Click Next.
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7. Follow these steps from this dialog box.

a. Browse to the location of the firmware source files on your computer, 
where the FUP was installed.
The default location is shown.

b. Choose the version of the update firmware from the pull-down 
menu.

c. Click Next.
It can take several seconds for the next dialog box to appear while the 
FUP is being retrieved.

8. From this dialog box, optionally select the KEPServer drivers that you 
want included in the firmware, then click Next.

Kepware drivers are already installed on the PanelView Plus 7 
Performance terminals.
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The final dialog box summarizes your choices for upgrading the terminal 
firmware.

9. Click Finish to update the firmware in the terminal. 

10. Click Yes to continue with the update.

A progress bar updates as firmware files are copied to the terminal.

11. Click OK when the firmware update is complete.

The terminal restarts and executes the new firmware.

IMPORTANT If the firmware update fails because of a power loss or the firmware update 
card is inadvertently removed, you can restore the terminal to the factory 
default firmware. See Maintenance Mode Operations on page 160 for 
details on how to restore the factory default settings.
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View System Information

View system information for the terminal from FactoryTalk® View ME Station 
runtime or from the Hardware Monitor in the control panel.

To view system information for the installed components, follow these steps.

1. Access FactoryTalk View ME Station runtime.

2. Tap Terminal Settings, then choose System Information>About 
FactoryTalk View ME Station.

Topic Page

View System Information 153

Status Indicators 154

View Network Status Information 155

Terminal Does Not Start Up 156

Terminal Restarts Intermittently 156

Touch Screen Issues 156

Display Issues 157

Ethernet Issues 158

Performance Is Slow 158

Resistance to Chemicals 158

Clean the Terminal Display 159

Ship the Terminal 160

Maintenance Mode Operations 160

IMPORTANT This document describes troubleshooting procedures for the 
PanelView® Plus 7 Performance terminal only. 

If your terminal is part of the ArmorView Plus 7 product, see the ArmorView 
Plus 7 Installation Instructions, publication 2711P-IN013, for instructions on 
how to gain physical access to the PanelView Plus 7 Performance terminal. 
After you gain access, follow the instructions in this chapter for 
troubleshooting the PanelView Plus 7 Performance terminal.

https://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711p-in013_-en-p.pdf
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Status Indicators The back of the terminal has two indicators to identify system status:
• STS indicator (green) indicates that the terminal is on and running
• ERR indicator (red) indicates hardware and firmware faults

At startup, the STS and ERR indicators flash on and off, then the STS 
indicator flashes to signal progress during startup. If the indicators remain off, 
check the power cable.

After a successful startup, the STS indicator remains on.

Table 36 shows indicator states if the terminal stops during startup.

Table 36 - Fault Indicator States During Terminal Startup

ERR (red) STS (green) Description Recommended Action

Blinking Off

Recoverable firmware error. Reload the firmware.

Recoverable configuration failure. Restore the terminal to its factory 
default image. See Restore a Back-up 
Image on page 96.

On
On Fatal hardware error. Replace the terminal.

Blinking Fatal display hardware error. Replace the terminal.

STS

ERR

The aluminum terminal is shown. The status indicators are the 
same on the stainless steel terminal.
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View Network Status 
Information

To access network status information from the system tray, follow these steps. 

1. Double-click the network icon in the system tray.

2. To view the network status, click the Network Status Information tab.

Status Indicator Description

Port 1 status and Port 2 status

Gray Disabled or unknown.

Green Enabled and operating normally.

Yellow A non-fatal error condition exists.

Red An error condition exists that requires some manual intervention.

Network Status

Normal (green color) If network topology is Linear/Star, the network status is always normal.

Ring Fault (yellow color) A non-fatal error condition exists.

Loop Detected (red color) This value can only occur in a Linear/Star topology. It occurs when an 
unexpected loop occurs in the network. It may not be possible for the terminal 
to report this condition (the terminal may not be capable of detecting frames 
that it has sent).

Partial Fault (yellow color) A non-fatal error condition exists.

Rapid Fault (red color) An error condition exists that requires some manual intervention.

General Information

Network Topology Linear/Star
Ring

Supervisor IP Addr xxx.xxx.xxx.xxx format
(not applicable if in Linear/Star topology)

Supervisor MAC Addr xx:xx:xx:xx:xx:xx format
(not applicable if in Linear/Star topology)

Supervisor VLAN ID 8 bit numeric
(not applicable if in Linear/Star topology)
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Terminal Does Not Start Up If the terminal does not start up normally, check the table for possible causes.

Terminal Restarts 
Intermittently

If the terminal restarts intermittently, check the table for possible causes.

Touch Screen Issues If the touch screen is not responding correctly to touches with a finger or 
stylus, check the table.

Table 37 - Terminal Does Not Start Up Properly

Check For What to Do See This Page

Insufficient power Make sure that device is receiving adequate power.
• Check the DC power requirements.
• Check the AC power requirements

 
page 41
page 42

Improper power 
wiring

Verify that the power wiring is correct.
• Check the wiring specifications.
• Check the DC power wiring.
• Check the AC power wiring.

page 40
page 41
page 42

Status indicators Check the status indicators during startup. page 154

Stalled progress 
indicator

If a terminal stalls at the progress indicator and does not load an 
application or configuration screens, reload the firmware or restore 
factory defaults.

page 96

Object touching 
the display

Verify that nothing is pressing against the display or that you are not 
touching the display during startup.

Not applicable

Table 38 - Terminal Restarts Intermittently

Check For What to Do See This Page

Improper power 
wiring

Verify that the power wiring is correct.
• Check the wiring specifications.
• Check the DC power wiring.
• Check the AC power wiring.

page 40
page 41
page 42

Over-temperature 
conditions

Make sure that the processor is not exceeding temperatures for 
normal terminal operations.
• Check the processor temperature.
• Check the System Event log for over-temperature conditions.
• Check for adequate clearances around the terminal in the panel.
• Check for proper operating temperature.

page 80 or page 101
page 79 or page 100
page 28
page 101

Table 39 - Touch Screen Not Responding

Check For What to Do See This 
Page

Improper calibration Check for activation points that are offset from touch points.
Calibrate the touch screen.

page 73 or 
page 125

Non-functioning 
touch screen

Check the touch screen for damage, such as cuts or excessive wear. If 
there is damage, replace the terminal.

Not applicable

Touching multiple 
input elements

Application screens contain graphic input elements that are configured 
in the Machine Edition application. When touched, these elements 
perform operations in a predictable manner. For example, an input 
element is configured to navigate to a specific screen in the application 
or start a motor when touched.
Multiple operations cannot be conducted simultaneously. Doing so 
results in an unintended operation.
• Do not touch multiple input elements simultaneously. 
• Do not rest a hand or multiple fingers on the display.

Not applicable
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Display Issues The display is unreadable or dims unexpectedly.

ATTENTION: If the display darkens, or if the backlight is not functioning 
properly, the screen can be difficult to read and use of this touch screen 
could result in a potentially hazardous outcome. Do not use the touch 
screen under these circumstances. The design of the system must take 
into account the possibility of the touch screen losing functionality and 
unable to be used to maintain or change control of the system. The touch 
screen shall not be the single point of control of critical functions and is not 
intended to replace an E-stop.

Design of the system should follow all applicable code and good engineering 
practice. Factors to consider include:

• The possibility of an unreadable touch screen

• The possibility of an inoperable touch screen

• Unexpected communication errors or delays

• Operator error in the control of the system

• Proper use of E-stops and other safety practices

The user shall provide means to achieve a safe state during anomalies and 
make sure the system has adequate redundancy for critical functions.

Failure to follow these instructions can result in death, serious injury, 
or equipment damage.

Table 40 - Dim Display

Check For See These Pages

Low display brightness setting page 70 or page 98

Low brightness level of screen saver page 70 or page 98

Temperatures outside the operating range page 80 or page 101

TIP Extend the life of the backlight by reducing the display brightness, by using 
the screen saver with reduced brightness, or operating at lower 
temperatures.
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Ethernet Issues Table 41 provides tips for isolating Ethernet anomalies. 

Performance Is Slow If the response time of the application is slow, for example screen changes or 
text display changes, check for the following issues:

• Application screens contain too many elements.
• If the controller is programmed for feedback, it can cause delays.
• Slow network performance or noise can result in retries.

Resistance to Chemicals The outer surfaces of the terminal including the bezel, touch screen overlay, 
and panel gasket seal are tested for chemical resistance. Some of the chemicals 
can cause discoloration, but they do not interfere with the operation of the 
terminal.

Table 41 - Ethernet Connection Issues

Check for These Issues What to Do

Status of invalid Ethernet connection • Green indicator is on when a link is established.
• Yellow indicator blinks when activity is detected.
• Verify network connections.

Poor cable connections Check the Ethernet cabling for the following:
• Make sure that cables are fully connected.
• Check for cable crimping.
• Check the Ethernet switch connections.
• Check the Uplink ports.

Invalid IP address of terminal Go to Set the Ethernet Address of the Terminal on page 62.
If DHCP is enabled, the terminal automatically acquires a valid IP 
address from the network after startup. The TCP/IP protocol 
automatically assigns 169.254.xxx.xxx when it fails to acquire an 
IP address from the network. In general, an IP address that begins 
with 169 does not support a network connection.

Conflicting IP addresses If DHCP is not enabled and a static IP address is specified, make 
sure that the IP address does not conflict with the address of 
another device on the network.

TIP For more information on chemical resistance of the product, go to
https://rockwellautomation.custhelp.com and search the Knowledgebase 
for keywords ‘Chemical Resistance PanelView Plus’.

IMPORTANT Do not operate the terminal in direct sunlight. Direct exposure to ultraviolet 
light can discolor the touch screen.

https://rockwellautomation.custhelp.com
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Clean the Terminal Display A protective overlay can help extend the life of the terminal and make it easier 
to clean the display. Table 6 on page 20 provides catalog numbers for overlays.
 

To clean the display, follow these steps.

1. Remove power from the terminal.

2. To clean the display and to help prevent scratches, use a clean sponge or 
soft cloth with mild soap or detergent.

3. To avoid water spots, dry the display with a chamois or moist cellulose 
sponge.

Remove Paint and Grease

To remove paint or grease from the bezel that is properly mounted in a NEMA, 
UL Type, or IP rated enclosure, follow these steps.

1. Rub lightly with isopropyl alcohol (70% concentration).

2. Use a mild soap or detergent solution to remove residue.

3. Rinse with clean water.

Equipment Wash Downs

ATTENTION: Do not use abrasive cleaners or solvents, they can damage the 
display. Do not scrub or use brushes.

Do not apply cleaning solution directly on the terminal screen. The solution can 
drip or seep onto the gasket. Apply cleaning solution to a clean sponge or soft 
cloth, and gently wipe the screen to remove the dirt and grime.

ATTENTION: Do not use a high-pressure washer for cleaning the front bezel 
of the terminal. A high-pressure washer can damage the terminal.

Do not use a high-pressure washer for cleaning vented enclosures. Water can 
enter the enclosure and damage the terminal and other equipment.

Remove power from the terminal before performing any wash downs. It is 
possible for screen objects to activate during equipment wash downs if the 
terminal is powered on. 

See Resistance to Chemicals on page 158 for information about exposure to 
chemicals.
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Ship the Terminal If you ship the enclosure with the terminal installed, make sure that the 
terminal is properly secured and protected against damage from impact, sharp 
objects, or abrasive materials.

Maintenance Mode 
Operations

To start the system in Maintenance Mode for diagnostics and repairs, press and 
hold the white box that shows in the lower left corner of the display during 
startup.

If an ME application is set to run at terminal startup, press and hold the white 
box during startup to put the terminal into Safe Mode.

Perform maintenance operation in this order to diagnose and repair problems:
• Safe mode – stops an application from starting automatically.
• Clear all data – removes user-installed applications, user-configuration 

changes, and user accessible data.
• Factory default – returns the terminal to its out-of-box state.

ATTENTION: Rockwell Automation is not responsible for damage to a 
product that is shipped or transported while installed in a panel or 
enclosure.

TIP You can also access the Maintenance Mode menu if you attach a 
USB keyboard and hold down the F1 key.

Table 42 - Maintenance Mode Operations

Operation Description 

None Exits Maintenance mode and continues with a normal restart.

Safe mode

Starts the system in Safe Operating mode. This mode is a diagnostic mode with reduced functionality that lets you recovery from a software anomaly. 
In Safe mode, you can repair applications or changes that caused the anomaly.
Important: FactoryTalk View ME Station software does not run the HMI .mer application on startup if one is loaded, but instead enters Configuration 
mode. The HMI application runs the next time that the system is reset.

Clear all data Restores all user-accessible storage and configuration data on the terminal to its default state. The current firmware revision is retained.
Important: All storage media is returned to its original state when purchased except for the firmware. The latest FactoryTalk View ME image is 
retained. All user data changes or additions are lost.

Factory default Restores all storage media on the terminal to its initial factory default state, including firmware, registry, file system, and configuration data. 
Typically, this option is used to recover from a failed firmware update.
Important: All storage media is returned to its original state when purchased. All user-installed, firmware updates are removed.
See Restore a Back-up Image on page 96 for details on how to perform a restore.
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Fonts Resident on Terminal

True Type Fonts The table lists TrueType fonts that are pre-installed on the terminals. The 
default system font is Tahoma. 

You can load additional fonts on the system by copying the font files to the 
\Windows\Fonts folder on the terminal desktop. To access this folder, open 
the My Device icon on the terminal desktop or choose 
Start>Programs>Windows Explorer. 

TIP The Arial Unicode MS font contains almost 50,000 characters and provides 
default language support for many non-Latin languages and scripts 
including Arabic, Hebrew, Vietnamese, Thai, Hindi (Devanagari), and other 
Indic languages. The font also includes Chinese, Japanese, and Korean (CJK) 
support.

IMPORTANT OpenType fonts (.otf) can contain many extra symbols and characters and 
can have large files sizes. If you install OpenType fonts, it can result in a 
reduction in available memory for applications. We recommend that you 
install only TrueType fonts. If you need an OpenType font, install only the 
font family that you want to use.

Table 43 - TrueType Fonts (.ttf and .ttc)

Font Type Font Name File Name

Latin Fonts Arial Unicode MS version 1.01 arialuni.ttf

Arial

Arial (Subset 1_30) arial_1_30.ttf

Arial Black arialk.ttf

Arial Bold arialbd.ttf

Arial Bold Italic arialbi.ttf

Arial Italic ariali.ttf

Comic Sans MS

Comic Sans MS comic.ttf

Comic Sans MS Bold comicbd.ttf

Courier New

Courier New (Subset 1_30) cour_1_30.ttf

Courier New Bold courbd.ttf

Courier New Bold Italic courbi.ttf

Courier New Italic couri.ttf
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Latin Fonts Georgia

Georgia georgia.ttf

Georgia Bold georgiab.ttf

Georgia Bold Italic georgiaz.ttf

Georgia Italic georgiai.ttf

Impact impact.ttf

Kino kino.ttf

Microsoft Logo mslogo.ttf

Symbol symbol.ttf

Tahoma

Tahoma (Subset 1_07) tahoma_1_07.ttf

Tahoma Bold tahomabd.ttf

Times New Roman

Times New Roman (Subset 1_30) times_1_30.ttf

Times New Roman Bold timesbd.ttf

Times New Roman Bold Italic timesbi.ttf

Times New Roman Italic timesi.ttf

Trebuchet MS

Trebuchet MS trebuc.ttf

Trebuchet MS Bold trebucbd.ttf

Trebuchet MS Bold Italic trebucbi.ttf

Trebuchet MS Italic trebucit.ttf

Verdana

Verdana verdana.ttf

Verdana Bold verdanab.ttf

Verdana Bold Italic verdanaz.ttf

Verdana Italic verdanai.ttf

Symbols Webdings webdings.ttf

Wingding wingding.ttf

Table 43 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
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PanelView™ Fonts PV 12 x 24, PV 12 x 8 PV12x24.tff, PV12x8.ttf

PV 16 x 24 PV16x24.ttf

PV 18 x 16, PV 18 x 8 PV18x16.ttf, PV18x8.ttf

PV 24 x 32 PV24x32.ttf

PV 32 x 40, PV 32 x 64 PV32x40.ttf, PV32x64.ttf

PV 4 x 6 PV4x6.ttf

PV 6 x 16, PV 6 x 24, PV 6 x 8, PV 6 x 9 PV6x16.ttf, PV6x24.ttf, 
PV6x8.ttf, PV6x9.ttf

PV 8 x 16, PV 8 x 20, PV 8 x 24 PV8x16.ttf, PV8x20.ttf, 
PV8x24.ttf

PV Double High PVdouble_high.ttf

PV Double Wide PVdouble_wide.ttf

PV Extra Large PVextra_large.ttf

PV Large PVlarge.ttf

PV Small PVsmall.ttf

PV Tiny PVtiny.ttf

PV Very Tiny PVvery_tiny.ttf

East Asian Fonts Gulim version 2.21 - Korean gulim.ttc

MS Gothic version 2.30 - Japanese gulim.ttc

Table 43 - TrueType Fonts (.ttf and .ttc) (Continued)

Font Type Font Name File Name
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Index

Symbols
.mer application 49, 50, 53, 60

A
access configuration mode

from an HMI application 49
from the Windows desktop 49
Goto Configuration Mode button 49

accessories 20
ActiveX controls 16, 91
alarms 79
application

backup 94
checking integrity 78
restore 94

atmospheric gases ignition temperature 25
authenticating client connections 104

B
back-up image 96
back-up power 136
battery

back-up power 136
conditions 101
lithium 136
replacement 137
view voltage 101
voltage 80
warnings 122

boot options 123
branch circuit 24
button styles 123

C
cable

capacitance 26
inductance 26
length between the Ethernet ports 44

calibration
touch screen 73, 125

catalog numbers
accessories 20
battery replacement 21
mounting hardware 20
PanelView Plus 7 performance terminals 19
power supplies 20
power terminal blocks 20
protective overlays 20
SD cards 20

circuit breaker rating 24
clear all data 160
closed system 17, 123
command prompt

Foxitreader 127
parameters 127
syntax 127

configuration mode 17

control panel
touch screen calibration 125

cutout dimensions 28

D
date

settings
date 84

DC power bus 41
desktop

rotate 99
desktop access

disable 55
enable 54
factory default state 17
open versus closed 17
reset password 57
restrict 55, 56
set password 56

device name
terminal 67

DHCP 62
diagnostics

advanced 124
configure 77

display settings
control panel 97

E
earth ground

AC 42
DC 41

electrostatic discharge 129
environment and enclosure notice 24
error indicator 154
ESD

preventing 129
Ethernet

connector pinout 44
driver 61
duplex setting 63
link speed 61
status indicators 44

Ethernet cables 21
event log

errors 100
events 100
warnings 100

explosion hazard 40, 134, 136

F
FactoryTalk View ME

check file integrity 78
diagnostics 78

fault indicators
firmware 154
hardware 154
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Index

file server
configuration 120

firmware upgrades
fail 152
firmware upgrade wizard 144
over network 149
using storage device 145

fonts 161
Foxitreader 127
FTP security options 118
FTP server

configuration 117
parameters 117
security 117

FUP 144
fuse rating 24
FUW 144

G
galvanic isolation 130

H
hardware specifications

audio out 13
Ethernet ports 13
mounting slot 13
SD card slot 13
status indicators 13
USB device port 13
USB host ports 13

I
indicator

ERR 154
STS 154

input panels 92
IP address

assign 62

K
KEPServer drivers 121, 147, 151

L
ladder logic 7
language 85

setting 85
lithium batteries

handling 122
logs

application files 78
runtime files 78

M
maintenance mode 160

ME 7
mount the terminal

ambient temperature 25
in a panel 28
location considerations 25
minimum clearances 28
preparation 29

N
network

file servers 120
FTP servers 117
topologies 18
VNC servers 107

network topology
device-level ring 45
linear 46
star 47

O
open system 17
open versus closed system 17

P
PDF reader 126
power

AC
connection 42
ratings 13, 42
terminal block 40

DC
connection 41
ratings 13, 41
terminal block 40

PELV 41
SELV 41
supplies 20

print setup 75
printers 131
product compatibility and download center 

8
protective overlay

catalog numbers 20
cleaning 139
installing 138
removing 139

publications
download 9

R
release notes 8
reset the terminal 48
RJ45 connector 43

S
safe mode 123, 160
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Index

safety notices
earth ground 41
electrical arc 40, 44
electrical shock 40, 42, 129
emergency stops 23
explosion hazard 25, 40, 44
wiring and safety guidelines 24

screen
rotate 99

screen saver 70
SD card

installing 134
server

addresses 64
enable/disable 105
file 120
ftp 117

settings
appearance 98
background image 97
backlight intensity 98
cursor 99
language 85
screen saver 98
time 84
time zone 83

shell options 122
soft keyboard controls 52
software versions

FactoryTalk View Machine Edition (ME) 
Station 15

FactoryTalk View Studio for Machine Edition 
15

FactoryTalk ViewPoint 15
startup

configure 17
options 17
sequence 47

startup options 17
static-safe workstation 129
status indicators 154
system

information 153
status 154

system event log 79

T
technical support 82
temperature

code T4 25
over-temperature messages 80
view 80
view current temperature 101

time 84
time zone 83
touch screen

calibrate 125
calibration 73
gestures

double-tap 15
drag 15

long press 15
tap 15

set sensitivity 74, 125
touch screen calibration 125
troubleshooting 153

U
USB

cables 131
host ports 26, 130
hubs 131
printer 131

USB ports
installation 26

USB to serial port adapters 21
user accounts 104

V
virtual keyboard 14
VNC

configure 106, 107
connection password 108
connection passwords 108
control passwords 109
server parameters 107
view-only password 109

W
watchdog errors 124
Web server parameters 116
wiring and safety guidelines 24
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Rockwell Automation Support
Use the following resources to access support information.

Documentation Feedback
Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve this document, complete the 
How Are We Doing? form at http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf.

Technical Support Center Knowledgebase Articles, How-to Videos, FAQs, Chat, User 
Forums, and Product Notification Updates.

https://rockwellautomation.custhelp.com/ 

Local Technical Support Phone Numbers Locate the phone number for your country. http://www.rockwellautomation.com/global/support/get-support-now.page 

Direct Dial Codes Find the Direct Dial Code for your product. Use the code to 
route your call directly to a technical support engineer. http://www.rockwellautomation.com/global/support/direct-dial.page 

Literature Library Installation Instructions, Manuals, Brochures, and 
Technical Data.

http://www.rockwellautomation.com/global/literature-library/overview.page 

Product Compatibility and Download 
Center (PCDC)

Get help determining how products interact, check 
features and capabilities, and find associated firmware.

http://www.rockwellautomation.com/global/support/pcdc.page 

.

Rockwell Otomasyon Ticaret A.Ş., Kar Plaza İş Merkezi E Blok Kat:6 34752 İçerenköy, İstanbul, Tel: +90 (216) 5698400

Rockwell Automation maintains current product environmental information on its Product Compliance website at
http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page.

Allen-Bradley, ArmorBlock, ArmorView, CompactLogix, ControlLogix, FactoryTalk, FLEX, Kinetix, PanelView, POINT I/O, PowerFlex, Rockwell Automation, Rockwell Software, RSLinx, Stratix, and Studio 5000 Logix Designer are 
trademarks of Rockwell Automation, Inc.

CIP Sync and EtherNet/IP are trademarks of ODVA, Inc.

Microsoft and Windows are trademarks of Microsoft Corporation.

SD and SDHC are trademarks of SD-3C LLC.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-compliance.page
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